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1. Introduction / Basics

This chapter provides basic information on operating an instrument via remote control.

1.1 Remote Control Interfaces

For remote control, LAN / USB (standard interface) or GPIB (optional interface) can be used. The optional GPIB inter-
face has its own interface module slot on the rear panel of the HMC8012.

I-=- Within this interface description, the term GPIB is used as a synonym for the IEC/IEEE bus interface.

SCPI (Standard Commands for Programmable Instruments) SCPI commands - messages - are used for remote control.
Commands that are not taken from the SCPI standard follow the SCPI syntax rules.

1.1.1 USB Interface

In addition to a LAN interface, the HMC8012 includes a USB device port. For this interface, the user can select if the
instrument is accessed via virtual COM port (VCP) or via USB TMC class. The traditional version of the VCP allows the
user to communicate with the HMC using any terminal program via SCPI commands once the corresponding Windows
drivers have been installed. For the multimeter HMC8012, these commands are mostly compatible with the Agilent
multimeters 34401A and 34410A. Naturally, the free HAMEG software “HMExplorer” is also available for the HMC
series. This Windows application offers HMC instruments a terminal function, the option to create screenshots and to
read out the measured data from the HMC memory.

The modern alternative to the virtual COM port is to remote control the HMC8012 via USB TMC class. TMC stands for
“Test & Measurement Class” which indicates that the connected measurement instrument can be recognized without
special Windows drivers if VISA drivers are installed and that it can be used directly in corresponding environments.
The GPIB interface serves as model to the structure of the TMC design. A major benefit of the USB TMC class is that
by sampling specific registers the controlling software can determine if commands have been terminated and if they
have been processed correctly. In contrast, the communication via VCP requires analysis and polling mechanisms
within the controlling software which may significantly strain the interface of the measurement instruments. The TMC
status registers solve this problem with the USB TMC in the same manner as is the case with the GPIB interface for
the hardware, namely via corresponding control lines.

If you are using USB you need to install an USB driver, which can be downloaded free of charge from the HAMEG
homepage.

I~=" Theavailable USB driver is fully tested, functional and released for Windows XP™ 32 Bit, Windows Vista™ or
Windows 7™ both as 32Bit or 64Bit versions.

The USB interface has to be chosen in the multimeter and does not need any setting.
I—="!f the virtual COM port will be used, you have to install the virtual COM port part of the HMC8012 USB driver.
The virtual COM port [VCP) will be activated in the PC device explorer.
1.1.2 LAN Interface
The settings of the parameter will be done after selecting the menu item Ethernet and the soft key Parame -
ter. You can set a fix IP adress or a dynamic IP setting via the DHCP function. Please ask your IT department for the
correct setting at your network.

IP address

To set up the connection the IP address of the instrument is required. It is part of the resource string used by the pro-
gram to identify and control the instrument. The resource string has the form:

TCPIP::«IP_address»::dP_port»:: SOCKET

The default port number for SCPI socket communication is 5025. IP address and port number are listed In the , Ether-
net Settings” of the HMC8012, see also: chapter 1.2.2,” Configuring LAN Parameters”, on page 4.
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Example: If the instrument has the IP address 192.1.2.3; the valid resource string is:
TCPIP::192.1.2.3::5025::SOCKET

If the LAN is supported by a DNS server, the host name can be used instead of the IP address. The DNS server
(Domain Name System server) translates the host name to the IP address. The resource string has the form:

TCPIP::<host_name»::«IP_port::SOCKET

To assign a host name to the HMC8012, select SETUP button» Misc» Device name.
Example: If the host name is HAMEG1; the valid resource string is:

TCPIP::HAMEG1::5025::SOCKET

B~=" The end character must be set to linefeed (LF).

1.1.3 GPIB Interface (IEC/IEEE Bus Interface)
In addition to the GPIB functions which are available via USB TMC class, the HMC8012 is optionally available with
an integrated GPIB interface. This solution is particularly attractive for customers who already have an existing GPIB
environment. With minimum efforts, an old instrument can be replaced by a model of the HMC8012.
To be able to control the instrument via the GPIB bus, the instrument and the controller must be linked by a GPIB bus
cable. A GPIB bus card, the card drivers and the program libraries for the programming language must be provided in
the controller. The controller addresses the instrument with the GPIB instrument address.
Characteristics
The GPIB interface is described by the following characteristics:
- Upto 15 instruments can be connected
- The total cable length is restricted to a maximum of 15m; the cable length between two instruments should not exceed
2m.
- Awired ,OR"-connection is used if several instruments are connected in parallel.
GPIB Instrument Address
In order to operate the instrument via remote control, it must be addressed using the GPIB address. The remote con-
trol address is factory-set to 20, but it can be changed in the network environment settings or in the ,Setup” menu
under , Interface » Parameter”. For remote control, a GPIB address from 0 to 30 are allowed. The GPIB address is
maintained after a reset of the instrument settings.
1.2 Setting Up a Network (LAN) Connection
1.2.1 Connecting the Instrument to the Network
The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps Ethernet IEEE 802.3u inter-
face.
E—=" Risk of network failure
Before connecting the instrument to the network or configuring the network, consult your network admini-
strator. Errors may affect the entire network.
I)-=- To establish a network connection, connect a commercial RJ-45 cable to one of the LAN ports of the instru-
ment and to a PC.
1.2.2 Configuring LAN Parameters
Depending on the network capacities, the TCP/IP address information for the instrument can be obtained in different
ways.
- If the network supports dynamic TCP/IP configuration using the Dynamic Host Configuration Protocol [DHCP), and a
DHCP server is available, all address information can be assigned automatically.
- Otherwise, the address must be set manually. Automatic Private IP Addressing (APIPA] is not supported.
HAMEG Instruments GmbH e Industriestr. 6 ¢ D-63533 Mainhausen ¢ Deutschland Subject to change without notice
Tel.: +49 (0) 6182 800 0  Fax: +49 (0) 6182 800 100 * E-Mail: info@hameg.com
Geschaftsfihrer: Dipl.-Ing. Holger Asmussen, Dipl.-Ing. Andre Vander Stichelen ¢ AG Offenbach am Main HRB 41200



HAMEL=

SCPI Commands HMC8012 Instruments

A Rohde & Schwarz Company

By default, the instrument is configured to use dynamic TCP/IP configuration and obtain all address information au-
tomatically. This means that it is safe to establish a physical connection to the LAN without any previous instrument
configuration.

I-=" Risk of network errors

Connection errors can affect the entire network. If your network does not support DHCP, or if you choose
to disable dynamic TCP/IP configuration, you must assign valid address information before connecting the
instrument to the LAN. Contact your network administrator to obtain a valid IP address.

Configuring LAN parameters

1.

2.

Press the SETUP key and then the Inter f ace softkey.
Pressthe Ethernet and then the Parameter softkey.

Note: By default, the instrument is set to not use DHCP. If the instrument is set to use DHCP and cannot find a DHCP
server, it takes about two minutes until the Ethernet menu is available.

The .Ethernet Settings” dialog box is displayed.

F-MODE
lauTo MAN
r

MEXT

Lirk
IP-Status: Manual IP obtained

Fig. 1.1: Ethernet Settings dialog box

Some data is displayed for information only and cannot be edited. This includes the ,MAC" (physical) address of the
connector and the ,, Link"” status information.

4.

Define the IP address of the instrument by entering each of the four blocks individually (manual mode) or choose the
automatic IP-Mode.

a) In manual mode [MAN) define the first block number using the knob.
b) Press Next to move to the next block and define the number.
c) When the IP address is complete, press Down to continue with the next setting.

Define the .Subnetmask” and .Gateway” in the same way.

. Select the ,RAW Port” - the port number for SCPI socket communication.

. Select the .VXI-11- Port” used by the instrument.

Select the . Transfer” mode. This mode can either be determined automatically (.Auto” setting), or you can select a
combination of a transfer rate and half or full duplex manually.

. Press Save to save the LAN parameters.
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= The Link" and ,IP-Status” information at the bottom of the dialog box indicates whether a LAN connection
was established successfully.

Checking LAN and SCPI connection
1. Check the LAN connection using ping: ping Xxx.yyy.ZZzZ.XXX.

2. Ifthe PC can access the instrument, enter the IP address of the address line of the internet browser on your computer:
http//:xxx.yyy.zzz.xxx

The .Instrument Home" page appears. It provides information on the instrument and the LAN connection.

J % HAMEG Instruments
& & B @ 160254120215 & | |B)- Googlc P ¥ # B~
T g
HRAMEL=
Instruments .
£ Rohde &Schwarz Company HAMEG Site | Support | Contact | Knowledge Base
Weuige, Device Information
M Settings
Security Device Model HMC8C12
Manufazturer HAMEG
Serial Number 000000000
Descriplon HAMEG HMC&012 - 000000000
Hostname TEST
MAC Address 00:04:A3:BC:E6:56
L
TCP/IP Address 169.254.120.215
Firmwareversion 00.07¢
VISA Device Address String TCPIP0::169.254.120.215::5025::50CKET
L
Device identification Enable
L g

Fig. 1.2: Web server

1.3 Switching to Remote Control

When you switch on the instrument, it is always in manual operation state (,local” state) and can be operated via the
front panel.

When you send a command from the control computer, it will be received and executed by the instrument. The display
remains on, manual operation via the front panel is always possible.
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1.4
1.4.1

Messages and Command Structure

Messages

Instrument messages are employed in the same way for all interfaces, if not indicated otherwise in the description.

See also:
- Structure and syntax of the instrument messages: chapter 1.4.2, .SCPI Command Structure”, on page 7

- Detailed description of all messages: chapter 2, .Command Reference”, on page 20

There are different types of instrument messages:
- Commands
- Instrument responses

Commands
Commands (program messages) are messages which the controller sends to the instrument. They operate the instru-

ment functions and request information. The commands are subdivided according to two criteria:
1. According to the effect they have on the instrument:
- Setting commands cause instrument settings such as a reset of the instrument or setting the frequency.

- Queries cause data to be provided for remote control, e.qg. for identification of the instrument or polling a
parameter value. Queries are formed by directly appending a question mark to the command header.

2. According to their definition in standards:

- The function and syntax of the Common commands are precisely defined in standard IEEE 488.2. They are
employed identically on all instruments (if implemented). They refer to functions such as management
of the standardized status registers, reset and self test.

- Instrument control commands refer to functions depending on the features of the instrument such as
frequency settings. Many of these commands have also been standardized by the SCPI committee. These
commands are marked as ,.SCPI compliant” in the command reference chapters. Commands without this
SCPI label are device-specific, however, their syntax follows SCPI rules as permitted by the standard.

Instrument responses
Instrument responses (response messages and service requests) are messages which the instrument is sent to the

controller after a query. They can contain measurement results, instrument settings and information on the instrument
status.

GPIB Interface Messages
Interface messages are transmitted to the instrument on the data lines, with the attention line (ATN) being active

(LOW). They are used for communication between the controller and the instrument and can only be sent by a compu-
ter which has the function of a GPIB bus controller. GPIB interface messages can be further subdivided into:

- Universal commands: act on all instruments connected to the GPIB bus without previous addressing

- Addressed commands: only act on instruments previously addressed as listeners

Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all instruments connected to the bus
and do not require addressing.

Addressed commands are encoded in the range 00 through OF hex. They only affect instruments addressed as
listeners.
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1.4.2 SCPI Command Structure
SCPI commands consist of a so-called header and, in most cases, one or more parameters. The header and the para-
meters are separated by a , white space” (ASCIl code 0t0 9, 11 to 32 decimal, e.g. blank). The headers may consist of
several mnemonics (keywords). Queries are formed by appending a question mark directly to the header.
The commands can be either device-specific or device-independent (common commands). Common and device-speci-
fic commands differ in their syntax.

Syntax for Common Commands

Common (= device-independent) commands consist of a header preceded by an asterisk (*) and possibly one or more

parameters.

Examples:

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable registers.
*ESR? EVENT STATUS QUERY Queries the contents of the event status register.
*IDN? IDENTIFICATION QUERY Queries the instrument identification string.

Table 1.4: Examples of Common Commands

Syntax for Device-Specific Commands

=" Not all commands used in the following examples are necessarily implemented in the instrument.

For demonstration purposes only, assume the existence of the following commands for this section:

- CALCulate:FUNCtion {NULL | DB | DBM | AVERage | LIMit}

- CALCulate:FUNCtion?

- CALCulate[:STATe] {OFF | ON}

- CALCulate[:STATe]?

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper case letters, the long form
corresponds to the complete word. Either the short form or the long form can be entered; other abbreviations are not
permitted.

Example:

CALCulate:FUNCtion NULL is equivalent to CALC:FUNC NULL

=" Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the manual, the instrument
itself is case-insensitive.
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Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or omitted. These mnemonics are
marked by square brackets in the description. The instrument must recognize the long command to comply with the
SCPI standard. Some commands are considerably shortened by these optional mnemonics.

Example:

INITiate[:IMMediate]

Definition:  INITiate[:IMMediate]

Command: INIT:IMM is equivalentto INIT

Special characters

| Parameters
A vertical stroke in parameter definitions indicates alternative possibilities in the sense of ,,or”. The
effect of the command differs, depending on which parameter is used.

Example:

Definition: UNIT:TEMPerature {C | K | F}

Command: UNIT:TEMP C selects °C for temperature measurements
Command: UNIT:TEMP K selects Kelvins for temperature measurements

[] Mnemonics in square brackets are optional and may be inserted into the header or omitted.
Example: INITiate[:IMMediate]

INIT:IMMis equivalentto INIT

{} Parameters in curly brackets are optional and can be inserted once or several times, or omitted.
Example: CALCulate:LIMit:LOWer {<Value> | MINimum | MAXimum}

The following are valid commands:

CALC:LIM:LOW 10

CALC:LIM:LOW MIN

CALC:LIM:LOW MAX

Table 1.5: Special characters

SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The parameters must be separated from
the header by a ,,white space” (ASCIl code 0 to 9, 11 to 32 decimal, e.g. blank). Allowed parameters are:

- Numeric values

- Special numeric values
- Boolean parameters

- Text

- Character strings

- Block data

The parameters required for each command and the allowed range of values are specified in the command description.
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Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent. Values exceeding the resolution
of the instrument are rounded up or down. The mantissa may comprise up to 255 characters, the exponent must lie
inside the value range -32000 to 32000. The exponent is introduced by an ,,E” or ,,e"”. Entry of the exponent alone is
not allowed. In the case of physical quantities, the unit can be entered. Allowed unit prefixes are MA (mega) / MOHM,
K (kilo), M (milli) and U (micro). If the unit is missing, the basic unit is used.

Example: CALC:NULL:OFF 10mV = CALC:NULL:OFF 10E-3

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a query, the numeric value is provided.

- MIN/MAX

MINimum and MAXimum denote the minimum and maximum value.
Example:
Setting command: CALCulate:LIMit:LOWer MAXimum
Query: CALC:LIM:LOW MAX?, Response: 1lE3

= Queries for special numeric values
The numeric values associated to MAXimum/MINimum can be queried by adding the corresponding mnemo-
nics to the command. They must be entered following the quotation mark.
Example: CALC:LIM:LOW? MAXimum

Returns the maximum numeric value as a result.

Boolean parameters

Boolean parameters represent two states. The ,,ON" state (logically true) is represented by ,,ON" or a numeric value
1. The ,,OFF" state (logically untrue) is represented by ,, OFF" or the numeric value 0. The numeric values are provided
as the response for a query.

Example:

Setting command: CALCulate[:STATe] ON
Query: CALC:STAT?

Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered using a short or long form. Like
any parameter, they have to be separated from the header by a white space. In the case of a query, the short form of
the text is provided.

Example:

Setting command: HCOPy:FORMat BMP

Query: HCOPy:FORMat ?

Response: BMP
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Overview of Syntax Elements

The following table provides an overview of the syntax elements:

The colon separates the mnemonics of a command. In a command line the separating semicolon-
marks the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

, The comma separates several parameters of a command.

? The question mark forms a query.

The asterisk marks a common command.

Quotation marks introduce a string and terminate it.

A ,white space” (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

Table 1.6: Syntax Elements

Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the following:
- a«New Line»

- a«New Line» with EQI

- an EQOl together with the last data byte

Several commands in a command line must be separated by a semicolon ,,;". If the next command belongs to a diffe-
rent command system, the semicolon is followed by a colon.

If the successive commands belong to the same system, having one or several levels in common, the command line
can be abbreviated. To this end, the second command after the semicolon starts with the level that lies below the
common levels. The colon following the semicolon must be omitted in this case.
Example: CALC:FUNC NULL; CALC ON
This command line is represented in its full length and contains two commands separated from each other by the
semicolon. Both commands are part of the CALC command system, i.e. they have one level in common. When abbre-
viating the command line, the second command begins with the level below CALC The colon after the semicolon is
omitted. The abbreviated form of the command line reads as follows:

CALC:FUNC NULL;ON
A new command line always begins with the complete path.
Example: CALC:FUNC NULL

CALC ON
Responses to Queries
A query is defined for each setting command unless explicitly specified otherwise. It is formed by adding a question
mark to the associated setting command. According to SCPI, the responses to queries are partly subject to stricter

rules than in standard |IEEE 488.2.

- The requested parameter is transmitted without a header.

Example: HCOPy:FORMat?,

Response: BMP
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- Maximum values, minimum values and all other quantities that are requested via a special text parameter are returned
as numeric values.

Example: CALCulate:LIMit:LOWer? MAXimum,
Response: 1E3

- Numeric values are output without a unit. Physical quantities are referred to the basic units or to the units set using the
Unit command. The response 3.5E9 in the previous example stands for 3.5 GHz.

- Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ONJ.

Example:

Setting command: CALCulate:STATe ON
Query: CALCulate:STATe?
Response: 1

1.5 Command Sequence and Synchronization
|IEEE 488.2 defines a distinction between overlapped and sequential commands:

- A sequential command finishes executing before the next command starts executing. Commands that are processed
quickly are usually implemented as sequential commands.

- An overlapping command does not automatically finish executing before the next command starts executing. Usually,
overlapping commands take longer to process and allow the program to do other tasks while being executed. If over-
lapping commands do have to be executed in a defined order, e.g. in order to avoid wrong measurement results, they
must be serviced sequentially. This is called synchronization between the controller and the instrument.

Setting commands within one command line, even though they may be implemented as sequential commands, are

not necessarily serviced in the order in which they have been received. In order to make sure that commands are actu-

ally carried out in a certain order, each command must be sent in a separate command line.

Example: Commands and queries in one message

The response to a query combined in a program message with commands that affect the queried value is not predictable.
The following commands always return the specified result:

:CALC:FUNC DB;CALC:STAT ON;CALC:DB:REF MAX :CALC:DB:REF?
Result: 7.500E+02

== Asageneralrule, send commands and queries in different program messages.
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1.5.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC, *OPC? or *WAI can be used. All
three commands cause a certain action only to be carried out after the hardware has been set. By suitable program-
ming, the controller can be forced to wait for the corresponding action to occur.

Command Action Programming the controller

*QOPC Sets the Operation Complete bit in the — Setting bit 0 in the ESE
ESRafter all previous commands have — Setting bit 5 in the SRE
been executed. — Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is Sending *OPC? directly after the command whose
returned.This is only the case after the processing should be terminated before other com-
Opera-tion Complete bit has been set mands can be executed.

in the ESR. This bit indicates that the
previous setting has been completed.

*WAI Stops further command processing until | Sending *WAI directly after the command whose
allcommands sent before *WAI have processing should be terminated before other com-
been executed. mands are executed

Table 1.7: Synchronization using *OPC, *OPC? and *WAI

Command synchronization using *WATI or *OPC? appended to an overlapped command is a good choice if the overlap-
ped command takes time to process. The two synchronization technigues simply block overlapped execution of the
command.

For time consuming overlapped commands it is usually desirable to allow the controller or the instrument to do other
useful work while waiting for command execution. Use one of the following methods:

*OPC with a service request
1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1
2. Set bitno. 5in the SRE: *SRE 32 to enable ESB service request.
3. Send the overlapped command with *OPC
4. Wait for a service request
The service request indicates that the overlapped command has finished.
*0OPC? with a service request
1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.
2. Send the overlapped command with *OPC?
3. Wait for a service request
The service request indicates that the overlapped command has finished.
Event Status Register (ESE)
1. Set the OPC mask bit (bit no. 0} in the ESE: *ESE 1
2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the sequence: *OPC; *ESR?
A return value (LSB] of 1 indicates that the overlapped command has finished.

HAMEG Instruments GmbH e Industriestr. 6 ¢ D-63533 Mainhausen ¢ Deutschland Subject to change without notice
Tel.: +49 (0) 6182 800 0  Fax: +49 (0) 6182 800 100 * E-Mail: info@hameg.com .
Geschaftsflihrer: Dipl.-Ing. Holger Asmussen, Dipl.-Ing. Andre Vander Stichelen ¢ AG Offenbach am Main HRB 41200 13



HRANMEL=
SCPI Commands HMC8012 Instruments
A Rohde & Schwarz Company

*0PC? with short timeout

1. Send the overlapped command without *OPC, *OPC? or *WAI

Poll the operation complete state periodically (by means of a timer] using the sequence: «short timeouty; *OPC?

3. A return value (LSB) of 1 indicates that the overlapped command has finished. In case of a timeout, the operation is
ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem:ERRor? to remove the ,-410, Query interrupted” entries.

N

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application supports threads, separate
threads can be used for the application GUI and for controlling the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with other instruments.

1.6 Status Reporting System

The status reporting system stores all information on the current operating state of the instrument, and on errors
which have occurred. This information is stored in the status registers and in the error queue. Both can be queried via
GPIB bus or LAN interface (STATus... commands).

1.6.1 Structure of a SCPI Status Register

Each standard SCPI register consists of b parts. Each part has a width of 16 bits and has different functions. The
individual bits are independent of each other, i.e. each hardware status is assigned a bit number which is valid for all
five parts. Bit 15 (the most significant bit) is set to zero for all parts. Thus the contents of the register parts can be
processed by the controller as positive integers.

Description of the five status register parts (please refer to page 20)
The five parts of a SCPI register have different properties and functions:

- CONDition
The CONDition partiswritten into directly by the hardware or the sum bit of the next lower register. Its contents reflect
the current instrument status. This register part can only be read, but not written into or cleared. Its contents are not
affected by reading.

- EVENt
The EVENt partindicates whether an event has occurred since the last reading, it is the .memory” of the condition part.
It only indicates events passed on by the transition filters. It is permanently updated by the instrument. This part can
only be read by the user. Reading the register clears it. This part is often equated with the entire register.

- ENABLle
The ENAB1le part determines whether the associated EVENt bit contributes to the sum bit [see below). Each bit of the
EVENt part is .,ANDed" with the associated ENABLe bit [symbol .&). The results of all logical operations of this part are
passed on to the sum bit via an .OR" function [symbol .+7].
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit ENABle bit = 1: if the associated EVENt bit
is .17, the sum bit is set to 1" as well. This part can be written into and read by the user as required. Its contents are
not affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result is then entered into a bit of the
CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event can lead to a service request
throughout all levels of the hierarchy.
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1.6.2 Hierarchy of status registers
The status information has an hierarchical structure.

- STB, SRE
The STatus Byte (STB] register and its associated mask register Service Request Enable (SRE) form the highest level of
the status reporting system. The STB provides a rough overview of the instrument status, collecting the information of
the lower-level registers.

- ESR, SCPI registers
The STB receives its information from the following registers:
- The Event Status Register (ESR] with the associated mask register standard Event Status Enable (ESE].
- The STATus:0OPERation and STATus:QUEStionable registers which are defined by SCPI and contain detailed
instrument information.

- Output buffer
The output buffer contains the messages the instrument returns to the controller. It is not part of the status reporting
system, but determines the value of the MAV bit in the STB and thus is represented in the overview.

All status registers have the same internal structure.

<= SRE, ESE

The service request enable register SRE can be used as ENAB1e part of the STB if the STB is structured
according to SCPI. By analogy, the ESE can be used as the ENAR1le part of the ESR.

1.6.3 Contents of the Status Registers

In the following sections, the contents of the status registers are described more detailed (please refer to page 20).
Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough overview of the instrument status by
collecting the pieces of information of the lower registers. A special feature is that bit 6 acts as the sum bit of the
remaining bits of the status byte.

The STB can thus be compared with the CONDition part of an SCPI register and assumes the highest level within the
SCPI hierarchy.

The STB is using the command *STB or a serial poll.

The sTatus Byte (STB)is linked to the Service Request Enable (SRE) register. Each bit of the STB is assigned a
bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set in the SRE and the associated bit in the STB changes from 0 to
1, a service request (SRQ) is generated. The SRE can be set by using the command *SRE and can be read by using the
command *SRE?.
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Bit No. | Meaning
0...1 Not used
2 Error Queue

The bit is set when an error is occured. If this bit is enabled by the SRE, each entry of the error
queue generates a service request. Thus an error can be recognized and specified in greater detail
by polling the error queue. The poll provides an informative error message. This procedure is to be
recommended since it considerably reduces the problems involved with remote control.

3 QUEStionable status sum bit
The bit is set, if an EVENt bit is set in the QUEStionable status register and the associated ENABle
bit is set to 1. A set bit indicates a questionable instrument status, which can be specified in detail
by polling the QUEStionable status register.

4 MAV bit (message available)
The bit is set, if a readable message in the output buffer is available. This bit can be used to enable
data to be automatical read from the instrument.

5 ESB bit
Sum bit of the event status register. It is set, if one of the bits in the event status register is set and
enabled in the event status enable register. Setting of this bit indicates a serious error, which can be
specified in greater detail by polling the event status register.

6 MSS bit (master status summary bit)
The bit is set, if the instrument triggers a service request. This is the case, if one of the other bits of
this register is set together with its mask bit in the service request enable register SRE.

7 OPERation status register sum bit

The bit is set, if an EVENt bit is set in the OPERation status register and the associated ENABle bit
is set to 1. A set bit indicates that the instrument is just performing an action. The type of action can
be determined by polling the OPERation status register.

Table 1.8: Bits of the status byte (please refer to page 20)

Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI register. The event status register
can be read out using command *ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE and the associated bit in the ESR
changes from 0 to 1, the ESB bit in the STB is set. The ESE register can be set using the command *ESE and read
using the command *ESE?.
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Bit No. | Meaning

0 Operation Complete
This bit is set on receipt of the command *OPC exactly, when all previous commands have been
executed.

1 Not used

2 Query Error
This bit is set, if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument instead.
The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error
This bit is set, if a device-dependent error occurs. An error message with a number between -300
and -399 or a positive error number is entered into the error queue.

4 Execution Error
This bit is set if a received command is syntactically correct, but cannot be performed for other rea-
sons. An error message with a number between -200 and -300 is entered into the error queue.

5 Command Error
This bit is set, if a command is received, which is undefined or syntactically incorrect. An error mes-
sage with a number between -100 and -200 is entered into the error queue.

6 Not used

7 Power On (supply voltage on)
This bit is set, when switching on the instrument.

Table 1.9: Bits of the event status register (please refer to page 20)

STATus:0OPERation Register

In the CONDition part, the register contains information which operations the instrument is being executing. In the
EVENTt part, it contains information which operations the instrument has executed since the last reading. It can be read
using the commands STATus :OPERation:CONDition? or STATus:0PERation[:EVENt]?.

The remote commands for the STATus:OPERation register are described on page 65.

Bit No. Meaning
0 Calibrating
(for service department only)
1to3 Not used
4 Measuring
The bit is set, while the instrument is measuring.
5 Waiting for Trig
This bit is set while the instrument is waiting for the trigger.
6to9 Not used
10 Instrument Locked (RWLock)
11to 15 Not used

Table 1.10: Bits of the STATus:OPERation register (please refer to page 20)
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STATus:QUEStionable Register

This register contains information about indefinite states which may occur, if the unit is operated without meeting the
specifications. It can be read using the commands STATus : QUEStionable:CONDition on page 66 and STATus:
QUEStionable[:EVENt] on page 67.

Bit No. Meaning

0 Voltage overrange
This bit is set, if a voltage range overload occurs.

1 Current overrange
This bit is set if a current range overload occurs.

2to 3 Not used

4 Temperature overrange
This bit is set if a temperature range overload occurs.

5 Frequency overload / underflow

This bit is set if a frequency range overload / underflow occurs.
6to 8 Not used
9 Resistance overrange

This bit is set if a resistance range overload occurs.

10 Capacitance overload / underflow
This bit is set if a capacitance range overload / underflow occurs.

11 Lower limit failed
This bit is set if a lower limit value is violated.

12 Upper limit failed
This bit is set if an upper limit value is violated.

13to 15 Not used

Table 1.11: Bits of the STATus:QUEStionable register [please refer to page 20)

1.6.4 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several devices in a measuring system.
The controller must receive and evaluate the information of all devices. The following standard methods are used:

- Service request (SRQJ initiated by the instrument

- Serial poll of all devices in the bus system, initiated by the controller in order to find out who sent a SRQ and why
- Parallel poll of all devices

- Query of a specific instrument status by means of commands

- Query of the error queue

Serial Poll

In a serial poll, with command *STB the status byte of an instrument is queried. The query is realized via interface mes-
sages and thus clearly faster. The serial poll method is defined in IEEE 488.1 and used to be the standard possibility for
different instruments to poll the status byte. The method also works for instruments, which do not adhere to SCPI or
IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instruments connected to the controller.
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Query of an instrument status
Each part of any status register can be read using queries. There are two types of commands:

- The common commands *ESR?, *IDN?, *STB? query the higher-level registers.
- The commands of the STATus system query the SCPI registers (STATus: QUEStionable. . .]

The returned value is always a decimal number that represents the bit pattern of the queried register. This number is
evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on the SRQ cause.

Decimal representation of a bit pattern (binary weights)

The STB and ESR registers contain 8 bits, the SCPI registers 16 bits. The contents of a status register are specified
and transferred as a single decimal number. To make this possible, each bit is assigned a weighted value. The decimal
number is calculated as the sum of the weighted values of all bits in the register that are set to 1.

Bits 0 |1 |2 3 4 5 6 7

Weight

1 2 4 ] 16 32 64 128

Fig. 1.7: Decimal representation of a bit pattern (please refer to page 20)

Example:

The decimal value 40 = 32 + 8 indicates that bits no. 3 and 5 in the status register (e.g. the QUEStionable status
summary bit and the ESB bit in the STatus Byte ) are set.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the error queue are de-

tailed plain text error messages that can be looked up in the error log or queried via remote control using
SYSTem:ERRor [ :NEXT] 2. Each call of SYSTem:ERRox [ :NEXT] ? provides one entry from the error queue. If no error
messages are stored, the instrument responds with 0, ,No error”.

The error queue should be queried after every SRQ in the controller program as the entries describe the cause of an er-
ror more precisely than the status registers. Especially in the test phase of a controller program the error queue should
be queried regularly since faulty commands from the controller to the instrument are recorded there as well.
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2 Command Reference

This chapter provides the description of all remote commands available for HMC8012. The commands are sorted
according to the menu structure of the instrument. A list of commands in alphabetical order ist given in the , List of
Commands” at the end of this documentation.

2.1 Common Commands
Common commands are described in the |EEE 488.2 (IEC 625-2) standard. These commands have the same effect

and are employed in the same way on different devices.The headers of these commands consist of ,, *" followed by
three letters. Many common commands are related to the Status Reporting System.

Available common commands:

*CLS
ClLear Status

Sets the status byte (STB), the standard event register (ESR) and the EVENTt part of the QUEStionable and the OPERa-
tion registers to zero. The command does not alter the mask and transition parts of the registers. It clears the output
buffer.

Usage: Setting only

*ESE <Value>
Event Status Enable

Sets the event status enable register to the specified value. The query returns the contents of the event status enable
register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?
Event Status Read
Returns the contents of the event status register in decimal form and subsequently sets the register to zero.

Return values:

<Contents> Range: 0 to 255

Usage: Query only
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*IDN?
IDeNtification: returns the instrument identification.

Return values:

<ID> HAMEG,device type»,«serial numben,firmwareversion
Example: HAMEG,HMC8012,12345,01.000

Usage: Query only

*OPC

OPeration Complete
Sets bit 0 in the event status register when all preceding commands have been executed. This bit can be used to ini-

tiate a service request. The query *OPC? writes a ,, 1" into the output buffer as soon as all preceding commands have
been executed. This is used for command synchronization.

*RST
ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the description of commands.

Usage: Setting only

*SRE <Contents>
Service Request Enable

Sets the service request enable register to the indicated value. This command determines under which conditions a
service request is triggered. The query *SRE? returns a decimal value of the Status Byte enable register which corre-
sponds to the binary-weighted sum of all bits.

Parameters:

<Contents> Contents of the service request enable register in decimal form.
Bit 6 (MSS mask bit) is always 0.

Range: 0 to 255

*STB?

STatus Byte query
Returns the contents of the status byte in decimal form.

Usage: Query only

*TRG
TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual trigger signal (Manual Trigger).
This common command complements the commands of the TRIGger subsystem.

Usage: Event
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*TST?
self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service Manual supplied with the
instrument). ,,0” indicates no errors occured.

Usage: Query only

*WAI
WAt to continue

Prevents servicing of the subsequent commands until all preceding commands have been executed and all signals
have settled (see also command synchronization and *OPC).

Usage: Event

2.2 System related commands

BB T N 2 e 23
READ? ..o

SYSTemM:BEEPEr:STATE <State> ...t
SYSTEMIBEEPEIISTATE? ... 24
SYSTem:BEEPer[:IMMediate]

SYSTemM:ERROINNEXTI? oo 24
SY STEMILOCAL . .

SYSTem:REMote
SYSTem:RWLock
SY STEMIVERSION? e 24

FETCh?

Query the actual measurement value on the display in auto trigger, single trigger or manual trigger mode. In contrast
to the READ? command the FETC? command does not initialize a trigger. By sending the *TRG command before the
FETC? command you get the actual triggered measurement value.

Usage: Query only

READ?

Query the actual measurement value in auto trigger mode. In the single trigger mode the READ? command initialize
a trigger with the settings for trigger count or interval. In the trigger manual mode the READ? command initialize a
trigger. By sending the READ? command again the trigger mode stops. Please notice that the READ? command only
queries the first measurement value of the trigger system.

Usage: Query only
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SYSTem:BEEPer:STATe <State>
Switches the front panel control beeper on or off. For example, if the control beeper is disabled, you don’t get a control
beep during the manual or signgle trigger.

Parameters:
<State> ON | OFF

*RST: ON
SYSTem:BEEPer:STATe?

Returns the state of the front panel control beeper. Returns “0" for deactivated (OFF) and “1"” for activated (ON)
control beeper.

*RST: 1

SYSTem:BEEPer[:IMMediate]
The instrument returns a single beep immediately.

Usage: Setting only

SYSTem:ERRor[:NEXT]?

Queries an error and removes it from the queue. Positive error numbers are instrument-dependent. Negative error
numbers are

reserved by the SCPI standard. If the queue is empty, the response is 0, “No error”.

Usage: Query only

SYSTem:LOCal

Sets the system to front panel control. The front panel control is unlocked.
Usage: Setting only

SYSTem:REMote

Sets the system to remote state. The front panel control is locked and can be unlock via soft menu key , Unlock keys”
(front panel) or SCPI command SYSTem:LOCal.

Usage: Setting only

SYSTem:RWLock
Sets the system to remote state. The front panel control is locked and can not be unlocked via soft menu key ,,Unlock
keys" (front panel). You are only able to unlock the front panel control via SCPI command SYSTem:LOCal.

Usage: Setting only

SYSTem:VERSion?
Returns the version of the SCPI (= Standard Commands for Programmable Instruments) standard.

Usage: Query only
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2.3 Display commands

DISPIaY: TEXT:CLEAN .. .ot 25
DISPlay: TEXTL:DATA] L, <StiNG>" .o 25
DISPlay:TEXT:CLEar

Clears the text message box on the front display.

Usage: Setting only

DISPlay:TEXTI[:DATA] ,,<string>"
Displays a text message box on the front display.

Example: DISP:TEXT ,, WAITING FOR TRIGGER"

Local Lag VCP Auto

2w = x _ s Rl_r :
Fange: 4l 2nd Ange

12.382 mV~ [

Up
~ Rermaote Control

Rai - i

"
WAITIMNG FOR TRIGGER Range
' Do
TERT[DATA] [ &
o 2nd
Function

r
P4 GE 1)2

Fig. 2.1: Display text example
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2.4 Trigger commands

TRIGger:COUNt {<Count>IMINIMAXIDEFaUIt}.......cccoooiiiiiiiiiiieeieeeeee 26
TRIGger:COUNt? [MINIimumIMAXIMUM] ... 26
TRIGger:INTerval {<Seconds>IMINIMAXIDEF} .......ccocciiiiiiiiiiie 26
TRIGger:INTerval? [{MINIMAXH ... 27
TRIGger:LEVel {<Level>IMINIMAXIDEF} ... 27
TRIGger:LEVEl? [{IMINIMAXI ..o 27
TRIGger:LEVel:MODe {CONTinue | ABOVEIBELOW} ........oovoiiiiiiiiciie 27
TRIGGErLEVEEMODE? ..o 27
TRIGEr:MODE {KMOAE>}.....oiiiiiiice e 28
TRIGGENMODE? .. 28

TRIGger:COUNt {<Count>|MINIMAXIDEFault}
Selects the number of triggers for the single trigger mode before returning to the ,idle” trigger state.

Parameters:
<Count> Trigger count value in single trigger mode.

<Count>: 1 to 50,000

MIN: 1
MAX: 50,000
DEFault: 1
*RST: 1

TRIGger:COUNt? [MINimum|MAXimum]
Returns the trigger count of the single trigger mode.

Return values:

<Count> 1 to 50,000
MIN: 1.0E+00
MAX: 5.00000E+04

TRIGger:INTerval {<Seconds>|MINIMAXIDEF}
Selects the trigger time interval for the single trigger mode before returning to the ,idle” trigger state.

Parameters:
<Interval> Trigger time interval value in single trigger mode.
<Seconds>: 0 to 3,600s
MIN: Os
MAX: 3,600s
DEFault: Os
*RST: 0.0E+00s
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Returns the trigger time interval for the single trigger mode before returning to the ,idle” trigger state.

Return values:

<Interval> Trigger time interval value in single trigger mode.

<Seconds>: 0 to 3,600s
MIN: 0.0E+00s
MAX: 3.6000E+03s

TRIGger:LEVel {<Level>|MINIMAXI|DEF}
Selects the trigger level (threshold) for the auto trigger mode.

Parameters:

<Level> Trigger threshold value in auto trigger mode.

<Level>: -750V to 750V

MIN: -750V
MAX: 750V
DEFault: oV

*RST: 0.0E+00V

TRIGger:LEVel? [{MINIMAX}]
Selects the trigger level (threshold) for the auto trigger mode.

Return values:

<Level> Trigger threshold value in auto trigger mode.

<Level>: -750V to 760V
MIN: -7.5000E+02
MAX: 7.5000E+02

TRIGger:LEVel:MODe {CONTinue | ABOVe|BELow}
Selects the trigger level mode in the auto trigger mode.

Parameters:
<Level Mode» Trigger level in auto mode
CONTinue: Continuous mode
ABOVe: Upper threshold trigger level
BELow: Lower threshold trigger level
*RST: CONT
TRIGger:LEVel:MODe?

Returns the trigger level mode in the auto trigger mode.

Return values:
«Level Mode» Trigger level in auto mode

CONTinue: Continuous mode
ABOVe: Upper threshold trigger level
BELow: Lower threshold trigger level
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TRIGger:MODE {<Mode>}
Selects the trigger mode.

Parameters:

<Mode> AUTO | MANual | SINGle
AUTO: Automatic trigger mode
MANual: Manual trigger mode
SINGle: Single trigger mode
*RST: AUTO

TRIGger:MODE?

Returns the trigger mode.

Return values:

<Mode> AUTO | MANual | SINGle
AUTO: Automatic trigger mode
MANual: Manual trigger mode
SINGle: Single trigger mode

2.4 Configuration and Measurement Commands

2.4.1 Measurement Commands

MEASure:CAPacitance? [{<Range>IAUTOIMINIMAXIDEFH .......cooooiiiiiiiiiiie, 28
MEASUrE:CONTINUITY 2.t 29
MEASure:CURRent:AC? [{<Range>IAUTOIMINIMAXIDEF} ......coooiiiiiiiiiiiiii, 29
MEASure:CURRent:DC? [{<Range>IAUTOIMINIMAXIDEF} ........ccccoviiiiiiiiiii, 29
MEASUIEIDIODE? ... 30
MEASure:FREQuency[:VOLTAGE]? [{<Range>IAUTOIMINIMAXIDEF}] ..........cc........ 30
MEASure:FREQuency:CURRent [{<Range>IAUTOIMINIMAXIDEF} ........c..ccoooiin. 30
MEASure:FRESistance? [{<Range>IAUTOIMINIMAXIDEF}H ... 31
MEASure:RESistance? [{<Range>IAUTOIMINIMAXIDEF} .........coooiiiiiiiiiiiiii, 31
MEASure:TEMPerature? [{<Probe_Type>IDEF},{<Type>IDEF}]..........ccccc.cooeiinn. 31
MEASure[:VOLTage]:AC? [{<Range>IAUTOIMINIMAXIDEF}H ......ooooiiiiiiiiiiie, 32
MEASure[:VOLTagel[:DCI]? [{<Range>IAUTOIMINIMAXIDEF} ..........oooiiiiiii, 32

MEASure:CAPacitance? [{<Range>|AUTOIMINIMAX|DEF}]
Configures the instrument for capacitance measurements. The displayed values (including statistic values) will be reset
and the instrument immediately triggers a measurement.

Return values:

<Range> 5nF, 50nF, 500nF, 5uF, 50uF, 500uF
AUTO: Auto range
MIN: 5nF
MAX: 500uF

DEFault: 5nF

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO
Usage: Query only
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MEASure:CONTinuity?
Configures the instrument for continuity measurements. The displayed value will be reset and the instrument immedia-
tely triggers a measurement.

Return values:
<Value> The command returns a single reading.
Range: 4000Q

Usage: Query only

MEASure:CURRent:AC? [{&Range->|AUTOIMIN|MAX|DEF}]
Configures the instrument for AC | measurements. The displayed values (including statistic values) will be reset and
the instrument immediately triggers a measurement.

Return values:

<Range> 20mA, 200mA, 2A, 10A
AUTO: Auto range
MIN: 20mA
MAX: 10A

DEFault: 20mA

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO

Usage: Query only

MEASure:CURRent:DC? [{<Range>|AUTO|MIN|MAXIDEF}]
Configures the instrument for DC | measurements. The displayed values (including statistic values) will be reset and
the instrument immediately triggers a measurement.

Return values:

<Range> 20mA, 200mA, 2A, 10A
AUTO: Auto range
MIN: 20mA
MAX: 10A

DEFault: 20mA

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO
Usage: Query only
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MEASure:DIODe?
Configures the instrument for diode tests. The displayed value will be reset and the instrument immediately triggers a
measurement.

Return values:

<Value> The command returns a single reading.
Range: 5V
Usage: Query only

MEASure:FREQuency[:VOLTAGE]? [{<Range>|AUTOIMINIMAXIDEF}]

Configures the instrument for frequency measurements with main function AC V. The displayed values (including stati-
stic values) will be reset and the instrument immediately triggers a measurement. Display of frequency is only available
as 2nd function for the main functions AC V and AC I.

Return values:

<Range> AC voltage: 400mV, 4V, 40V, 400V, 750V (5Hz to 700kHz)
AUTO: Auto range
MIN: 400mV
MAX: 750V

DEFault: 400mV

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

Usage: Query only

MEASure:FREQuency:CURRent [{<Range>|AUTOIMINIMAX|DEF}]

Configures the instrument for frequency measurements with main function AC I. The displayed values (including stati-
stic values) will be reset and the instrument immediately triggers a measurement. Display of frequency is only available
as 2nd function for the main functions AC V and AC |.

Return values:
<Range> AC current:  20mA, 200mA (5Hz to 10kHz)
2A, 10A (5Hz to 5kHz)

AUTO: Auto range
MIN: 20mA
MAX: 10A

DEFault: 20mA

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

Usage: Query only
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MEASure:FRESistance? [{<Range>|AUTO|MINIMAXIDEF}]
Configures the instrument for 4-wire resistance measurements. The displayed values (including statistic values) will be

reset and the instrument immediately triggers a measurement.

Return values:

<Range> 400Q), 4kQ, 40kQ, 400kQ, 4MQ
AUTO: Auto range
MIN: 400Q
MAX: 4MQ

DEFault: 400Q

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

Usage: Query only

MEASure:RESistance? [{<Range>|AUTOIMINIMAXIDEF}]
Configures the instrument for 2-wire resistance measurements. The displayed values (including statistic values) will be

reset and the instrument immediately triggers a measurement.

Return values:

<Range> 400Q, 4kQ, 40kQ, 400kQ, 4MQ, 40MQ, 250MQ
AUTO: Auto range
MIN: 400Q
MAX: 250MQ

DEFault: 400Q

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

Usage: Query only

MEASure:TEMPerature? [{<Probe_Type>|DEF}[,{<Type>IDEF}]
Configures the instrument for temperature measurements. The displayed values (including statistic values) will be

reset and the instrument immediately triggers a measurement.

Return values:
<Probe_Type> FRTD | RTD

FRTD: 4-wire temperature value (4W)
RTD: 2-wire temperature value (2W)
DEFault: RTD (2W)

<Type> PT100 | PT500 | PT1000
DEFault: PT100
Example: MEAS:TEMP? FRTD,PT500
Usage: Query only
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MEASure[:VOLTagel:AC? [{<Range>|AUTO|MINIMAXIDEF}]
Configures the instrument for AC V measurements. The displayed values (including statistic values) will be reset and
the instrument immediately triggers a measurement.

Return values:

<Range> 400mV, 4V, 40V, 400V, 750V
AUTO: Auto range
MIN: 400mV
MAX: 750V

DEFault: 400mV

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

Usage: Query only

MEASure[:VOLTagell:DC]? [{<Range>|AUTO|MINIMAXIDEF}]
Configures the instrument for DC V measurements. The displayed values (including statistic values) will be reset and
the instrument immediately triggers a measurement.

Return values:

<Range> 400mV, 4V, 40V, 400V, 1000V
AUTO: Auto range
MIN: 400mV
MAX: 1000V

DEFault: 400mV

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

Usage: Query only
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2.4.2 Configuration commands

Capacitance configuration commands

CONFigure:CAPacitance [{<Range>IAUTOIMINIMAXIDEF} .....cccooooiiiiiiiiii 33
[SENSe:]CAPacitance:NULLESTATE] {ONIOFF} . ..o 33
[SENSe:]CAPacitanCce:NULLLSTATE]? ..o 33
[SENSe:]CAPacitance:NULL:VALue {<Value>IMINIMAX} .........ccooiiiiiiiiiiii 34
[SENSe:]CAPacitance:NULL:VALue? {MINIMAX} ... 34
[SENSe:]CAPacitance:RANGE:AUTO <MOAE> ......vvuviiiiiiiieiee e 34
[SENSe:]CAPacitance:RANGEAUTO? ... 34
[SENSe:]CAPacitance:RANGe[:UPPer] {<Range>IMINIMAXIDEF} ..........cooooiiiin. 34
[SENSe:]CAPacitance:RANGe[:UPPer]? [[MINIMAXIDEFR} ... 35

CONFigure:CAPacitance [{<Range>|AUTOIMINIMAXIDEF}]

Configures the instrument for capacitance measurements, but does not initiate a measurement. Use the READ?
command to query the capacitance measurement value with specified range or the CONF? command to query the
capacitance function configuration.

Parameters:

<Range> 5nF, 50nF, 500nF, 5uF, 50uF, 500uF
AUTO: Auto range
MIN: 5nF
MAX: 500uF

DEFault: 5nF

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO

[SENSe:ICAPacitance:NULL[:STATe]l {ON|OFF}
Turns the null function for capacitance measurements on or off. In this case, the instrument does not switch into capa-
citance mode. For activating the capacitance measurement function use the FUNC command.

Parameters:
<State> ON | OFF

*RST:  OFF

[SENSe:ICAPacitance:NULL[:STATe]?
Returns the NULL function state of the capacitance measurement function.

Return values:

<State> 110
1 ON - NULL function of the capacitance measurement function is activated
0 OFF - NULL function of the capacitance measurement function is disabled
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[SENSe:ICAPacitance:NULL:VALue {<Value>|MINIMAX}
Sets the null value of the capacitance measurement function.

Parameters:

<Value> 0 to b0OuF (adjustable in 1fF steps)
MIN: OF
MAX: 500uF
*RST. OF

[SENSe:]1CAPacitance:NULL:VALue? [{MIN|MAX}]
Returns the null value of the capacitance measurement function.

Return values:
<Value> 0 to 500pF

MIN: 0.0E+00
MAX:  5.000000E-04

[SENSe:ICAPacitance:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the capacitance measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the capacitance measurement function
OFF: Disables the auto range mode of the capacitance measurement function
1: Activates the auto range mode of the capacitance measurement function
0: Disables the auto range mode of the capacitance measurement function
*RST:  ON

[SENSe:]ICAPacitance:RANGe:AUTO?
Returns the auto mode state of the capacitance measurement function.

Return values:

<State> 110
1: Auto range of the capacitance measurement function is activated
0: Auto range of the capacitance measurement function is disabled

[SENSe:ICAPacitance:RANGe[:UPPer] {<Range>|MINIMAX|DEF}
Sets the capacitance measurement function range.

Parameters:
<Range> 5nF, 50nF, 500nF, 5uF, 50uF, 500uF
MIN: 5nF
MAX: 500pF
DEFault: 5nF
*RST: AUTO
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[SENSe:]1CAPacitance:RANGe[:UPPer]? [{MINIMAXIDEF}]
Returns the state of the capacitance measurement function range.

Return values:
<Range> 5nF, 50nF, 500nF, 5pF, 50uF, 500uF

MIN:  5.00000000E-09

MAX:  5.00000000E-04
DEF: 5.00000000E-09

Continuity configuration commands

CONFIgUrE:CONTINUILY .t 35
[SENSe:JCONTinuity: THReshold {<Threshold>IMINIMAXIDEF}............cc.coovivieennn. 35
[SENSe:]JCONTinuity: THReshold? [{MINIMAXIDEF} ........ooooiiiiiiie e 35
[SENSe:ICONTinuity:BEEPer[:STATe] {ONIOFF}........ooiiiiieee e 36
[SENSe:ICONTInuity:BEEPErl:STATEI? ...coooiiiiie e 36

CONFigure:CONTinuity
Configures the instrument for continuity measurements, but does not initiate a measurement. Use the READ? com-
mand to query the continuity measurement value or the CONF? command to query the general function configuration.

[SENSe:1CONTinuity:THReshold {<Threshold>|MINIMAXIDEF}
Sets the threshold of the continuity measurement function. In this case, the instrument does not switch into continuity
mode. For activating the continuity measurement function use the FUNC command.

Parameters:

<Threshold> 0Q to TMQ (adjustable in 1Q steps)
MIN: 0Q
MAX:  1TMQ

DEFault: 200Q

*RST:  200Q
[SENSe:]1CONTinuity:THReshold? [{MIN|MAX|DEF}]
Returns the threshold of the continuity measurement function.

Return values:
<Threshold> 0Q to TMQ

MIN:  0.00000000E+00
MAX:  1.00000000E+06
DEFault: 2.00000000E+02
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[SENSe:]ICONTinuity:BEEPer[:STATe]l {ONIOFF}
Activates or disables the beeper of the continuity measurement function.

Parameters:

<State> ON | OFF
ON: Activates the beeper function of the continuity measurement function
OFF: Disables the beeper function of the continuity measurement function
*RST: OFF

[SENSe:]1CONTinuity:BEEPer[:STATe]?
Returns the beeper state of the continuity measurement function.

Return values:

<State> 110
1 Beeper of the continuity measurement function is activated
0: Beeper of the continuity measurement function is disabled

AC | configuration commands

CONFigure:CURRent:AC [{<Range>IAUTOIMINIMAXIDEF}.........ccoooiiiiiiiiice, 36
[SENSe:]CURRent:AC:BANDwidth {<Threshold>IMINIMAXIDEF}.............c............... 37
[SENSe:]CURRent: AC:BANDwidth? {MINIMAX ..o 37
[SENSe:]CURRent: AC:NULL[:STATe] {ONIOFF} ... 37
[SENSe:]CURReNt: AC:INULLLESTATEI? ...oveeeeeeeeeee e 37
[SENSe:]CURRent:AC:NULL:VALue {<Value>IMINIMAX}..........ccooiiiiiiiiiiii 38
[SENSe:]CURRent: AC:NULL:VALue? [{MINIMAXH .....oooiiiiieeei e, 38
[SENSe:]CURRent:AC:RANGE:AUTO <MOAE> ....ovvoviiiiee e 38
[SENSe:]CURRent: AC:RANGE:AUTO? ..o 38
[SENSe:]CURRent:AC:RANGe[:UPPer] {<Range>IMINIMAXIDEF}...........ccooiiiinn 38
[SENSe:]CURRent:AC:RANGe[:UPPer]? [{IMINIMAXH ... 39

CONFigure:CURRent:AC [{<Range>|AUTOIMINIMAXIDEF}]
Configures the instrument for AC | measurements, but does not initiate a measurement. Use the READ? command to
query the AC | measurement value with specified range or the CONF? command to query the AC | function configura-

tion.
Parameters:
<Range> 20mA, 200mA, 2A, 10A
AUTO: Auto range
MIN: 20mA
MAX: 10A
DEFault: 20mA
If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.
*RST: AUTO
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[SENSe:ICURRent:AC:BANDwidth {<Threshold>|MIN|MAXIDEF}
Sets the AC filter of the AC | measurement function.

Parameters:

<Threshold> 101501400
10: 10Hz filter (Slow)
50: 50Hz filter (Medium)
400: 400Hz filter (Fast)
MIN: Slow
MAX:  Fast
DEF: Slow

*RST:  5.00000000E+01

[SENSe:1CURRent:AC:BANDwidth? [{MINIMAX}]
Returns the AC filter state of the AC | measurement function.

Return values:
<State> 1.00000000E+01 | 5.0000000E+1 | 4.00000000E+02

MIN: 1.00000000E+01 (Slow)
MAX:  4.00000000E+02 (Fast)

[SENSe:I1CURRent:AC:NULL[:STATe] {ONIOFF}
Turns the null function for AC | measurements on or off. In this case, the instrument does not switch into AC | mode.
For activating the AC | measurement function use the FUNC command.

Parameters:

<State> ON | OFF
ON: Null function of AC | measurements is activated
OFF: Null function of AC | measurements is disabled
*RST:  OFF

[SENSe:1CURRent:AC:NULL[:STATel?
Returns the NULL function state of the AC | measurement function.

Return values:

<State> 110
1 ON - NULL function activated
0 OFF - NULL function disabled
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[SENSe:]ICURRent:AC:NULL:VALue {<Value>|MINIMAX}
Sets the null value of the AC | measurement function.

Parameters:

<Value> -10V to 10A (adjustable in 10pA steps)
MIN: -10A
MAX: 10A
*RST. 0A

[SENSe:ICURRent:AC:NULL:VALue? [{MINIMAX}]
Returns the null value of the AC | measurement function.

Return values:
<Value> -10A to 10A

MIN:  -1.000000E+01
MAX:  1.000000E+01

[SENSe:1CURRent:AC:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the AC | measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the AC | measurement function
OFF: Disables the auto range mode of the AC | measurement function
1 Activates the auto range mode of the AC | measurement function
0: Disables the auto range mode of the AC | measurement function
*RST:  ON

[SENSe:ICURRent:AC:RANGe:AUTO?
Returns the auto mode state of the AC | measurement function.

Return values:

<State> 110
1: Auto range of the AC | measurement function is activated
0: Auto range of the AC | measurement function is disabled

[SENSe:ICURRent:AC:RANGe[:UPPer] {<Range>|MINIMAXI|DEF}
Sets the AC | measurement function range.

Parameters:
<Range> 20mA, 200mA, 2A, 10A
MIN: 20e-3
MAX: Te+1
DEFault: 20e-3
*RST: AUTO
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[SENSe:ICURRent:AC:RANGe[:UPPerl]? [{MINIMAX}]
Returns the state of the AC | measurement function range.

Return values:
<Range> 20mA, 200mA, 2A, 10A

MIN: ~ 2.00000000E-02

MAX:  1.00000000E+01
DEFault: 2.00000000E-02

AC V configuration commands

CONFigure[:VOLTagel:AC [{<Range>IAUTOIMINIMAXIDEF}H.......c.cooiviriiiiiiiiin, 39
[SENSe:]VOLTage:AC:BANDwidth {<Filter>IMINIMAXIDEF} ...........cooooiiiiiiiiie, 39
[SENSe:]VOLTage:AC:BANDwidth? [{MINIMAX}H ....oooiiiiiiiiieeee e 40
[SENSe:]IVOLTage:AC:NULL[:STATE] {ONIOFF} ... 40
[SENSe:IVOLTage: AC:INULLESTATEI? ..oviiiiiieieee e 40
[SENSe:]IVOLTage:AC:NULL:VALue {<Value>IMINIMAX} .........cc..coooiiiiiiiiiiee 40
[SENSe:IVOLTage:AC:NULL:VALue? [{IMINIMAXH ....ocooiiiiiiiiiiiieeceeee 40
[SENSe:]VOLTage:AC:RANGe:AUTO <Mode> .......ccooviiiiiiiiiccciceeee e, 41
[SENSe:]IVOLTage:AC:RANGEAUTO? ..o 41
[SENSe:]IVOLTage:AC:RANGe[:UPPer] {<Range>IMINIMAXIDEF}..............ccoceevei.. 41
[SENSe:IVOLTage:AC:RANGe[:UPPer]? [{MINIMAXH .......coooiiiiieiiiiiiieeceee 41

CONFigure[:VOLTage]:AC [{<Range>|AUTO|MIN|MAXIDEF}]
Configures the instrument for AC V measurements, but does not initiate a measurement. Use the READ? command to
query the AC V measurement value with specified range or the CONF? command to query the AC V function configu-

ration.

Parameter:

<Range> 400mV, 4V, 40V, 400V, 750V
AUTO: Auto range
MIN: 400mV
MAX: 750V

DEFault: 400mV

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO

[SENSe:1VOLTage:AC:BANDwidth {<Filter>|MINIMAXIDEF}
Sets the AC filter of the AC V measurement function. In this case, the instrument does not switch into AC V mode. For
activating the AC V measurement function use the FUNC command.

Parameters:
<Filter> 10150 1400
10: 10Hz filter (Slow)
50: 50Hz filter (Medium)
400: 400Hz filter (Fast)
MIN: Slow
MAX:  Fast
DEFault: Slow
*RST:  5.00000000E+01
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[SENSe:1VOLTage:AC:BANDwidth? [{MIN|MAX}]
Returns the AC filter of the AC V measurement function.

Return values:
<Filter> 1.00000000E+01 | 5.00000000E+01 | 4.00000000E+02

MIN: 1.00000000E+01
MAX:  4.00000000E+02

[SENSe:1VOLTage:AC:NULL[:STATe] {ON|OFF}
Turns the null function for AC V measurement function on or off.

Parameters:

<State> ON | OFF
ON: Null function of AC V measurement function is activated
OFF: Null function of AC V measurement function is disabled
*RST:  OFF

[SENSe:1VOLTage:AC:NULL[:STATe]?
Returns the null function state of the AC V measurement function.

Return values:

<State> 110
1 ON - Null function of the AC V measurement function is activated
0 OFF - Null function of the AC V measurement function is disabled

[SENSe:1VOLTage:AC:NULL:VALue {<Value>|MIN|MAX}
Sets the null value of the AC V measurement function.

Parameters:

<Value> -750V to 750V (adjustable in 1nV steps)
MIN: -750V
MAX: 750V
*RST: 0Q

[SENSe:1VOLTage:AC:NULL:VALue? [{MINIMAX}]
Returns the null value of the AC V measurement function.

Return values:
<Value> -750V to 750V

MIN:  -7.500000E+02
MAX:  7.500000E+02
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[SENSe:1VOLTage:AC:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the AC V measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the AC V measurement function
OFF: Disables the auto range mode of the AC V measurement function
1 Activates the auto range mode of the AC V measurement function
0: Disables the auto range mode of the AC V measurement function

[SENSe:1VOLTage:AC:RANGe:AUTO?
Returns the auto mode state of the AC V measurement function.

Return values:

<State> 110
1 Auto range of the AC V measurement function is activated
0: Auto range of the AC V measurement function is disabled

[SENSe:]VOLTage:AC:RANGe[:UPPer] {<Range>|MINIMAXIDEF}
Sets the AC V measurement function range.

Parameters:

<Range> 400mV, 4V, 40V, 400V, 750V
MIN: 400mV
MAX: 750V

DEFault: 400mV

*RST: AUTO

[SENSe:1VOLTage:AC:RANGe[:UPPer]? [{MIN|MAX}]
Returns the state of the AC V measurement function range.

Return values:
<Range> 400mV, 4V, 40V, 400V, 750V

MIN: ~ 4.00000000E-01
MAX:  7.50000000E+02

Instruments

A Rohde & Schwarz Company
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DC I configuration commands

CONFigure:CURRent[:DC] [{<Range>IAUTOIMINIMAXIDEF} ......cccoocoeiiiii, 42
[SENSe:]CURRent[:DCI:NULL[:STATe] {ONIOFF} ... 42
[SENSe:]CURRENtE:DCENULLESTATEI? ..o 42
[SENSe:]CURRent[:DCI:NULL:VALue {<Value>IMINIMAX} ... 43
[SENSe:]CURRent[:DCINULL:VALue? {MINIMAXH .....oooiiiiieee e, 43
[SENSe:]CURRent[:DCI:RANGe:AUTO <MOAE> .....ooiiiiiiiie s 43
[SENSe:]CURReNt[:DCLERANGEAUTO? ..o 43
[SENSe:]CURRent[:DCI:RANGe[:UPPer] {<Range>IMINIMAXIDEF} ......................... 43
[SENSe:]CURRent[:DCI:RANGe[:UPPer]? {MINIMAX} ... 44

CONFigure:CURRent[:DC] [{<Range>|AUTO|MINIMAXIDEF}]
Configures the instrument for DC | measurements, but does not initiate a measurement. Use the READ? command to
query the DC | measurement value with specified range or the CONF? command to query the DC | function configura-

tion.

Parameters:

<Range> 20mA, 200mA, 2A, 10A
AUTO: Auto range
MIN: 20mA
MAX: 10A

DEFault: 20mA

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO

[SENSe:ICURRent[:DCI:NULL[:STATe] {ONIOFF}
Turns the null function for DC | measurements on or off. In this case, the instrument does not switch into DC | mode.
For activating the DC | measurement function use the FUNC command.

Parameters:
<State> ON | OFF

*RST:  OFF

[SENSe:ICURRent[:DC]:NULL[:STATel?
Returns the null function state of the DC | measurement function.

Return values:

<State> 110
1 ON - NULL function activated
0 OFF - NULL function disabled
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[SENSe:]ICURRent[:DC]:NULL:VALue {<Value>|MIN|MAX}
Sets the null value of the DC | measurement function.

Parameters:

<Value> -10A to 10A (adjustable in 10pA steps)
MIN: -10A
MAX: 10A
*RST: 0A

[SENSe:ICURRent[:DC]:NULL:VALue? [{MINIMAX}]
Returns the null value of the DC | measurement function.

Return values:
<Value> -10A to 10A

MIN:  -1.000000E+01
MAX:  1.000000E+01

[SENSe:ICURRent[:DCI:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the DC | measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the DC | measurement function
OFF: Disables the auto range mode of the DC | measurement function
1 Activates the auto range mode of the DC | measurement function
0: Disables the auto range mode of the DC | measurement function
*RST:  ON

[SENSe:1CURRent[:DCI:RANGe:AUTO?
Returns the auto mode state of the DC | measurement function.

Return values:

<State> 110
1: Auto range of the AC | measurement function is activated
0: Auto range of the AC | measurement function is disabled

[SENSe:1CURRent[:DC]:RANGe[:UPPer] {<Range>|MIN|MAXIDEF}
Sets the DC | measurement function range.

Parameters:
<Range> 20mA, 200mA, 2A, 10A
MIN: 20e-3
MAX: Te+1
DEFault: 20e-3
*RST: AUTO
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[SENSe:ICURRent[:DC]I:RANGe[:UPPer]? [{MINIMAX}]
Returns the state of the DC | measurement function range.

Return values:
<Range> 20mA, 200mA, 2A, 10A

MIN: ~ 2.00000000E-02

MAX:  1.00000000E+01
DEFault: 2.00000000E-02

DC V configuration commands

CONFigure[:VOLTagell:DC] [{<Range>IAUTOIMINIMAXIDEF} .......ccccooiiiiiiiin, 44
[SENSe:IVOLTage[:DCIINULLL:STATE] {ONIOFF}.....oiiiiiiiiiieccceeee 44
[SENSe:]VOLTage:DCENULLESTATEI? ..ot 45
[SENSe:]IVOLTage[:DCI:NULL:VALue {<Value>IMINIMAX} .......ccccoooiiiiiiiiiiiie 45
[SENSe:]IVOLTage[:DCIINULL:VALue? [{MINIMAXH. ....cooiiiiiiiiiiiii e 45
[SENSe:]IVOLTagel[:DCI:RANGe:AUTO <MOdE> .......coviiiiieiieeeeeeeeeeeeee e, 45
[SENSe:IVOLTage[:DCLERANGEAUTO? ..ot 45
[SENSe:]VOLTage[:DCl:RANGe[:UPPer] {<Range>IMINIMAXIDEF} .............ccoeeni.n. 46
[SENSe:]VOLTagel[:DCI:RANGe[:UPPer]? [[MINIMAXH .......cccooiiiiiiiiiiiiii 46
[SENSe:IVOLTage[:DCI:ZERO:AUTO <MOdE> ....oovviiiiiiiiciiicce e 46
[SENSe:IVOLTagel:DCI:ZERO:AUTO? ..ot 46

CONFigure[:VOLTage][:DC] [{<Range>|AUTO|MIN|MAXIDEF}]
Configures the instrument for DC V measurements, but does not initiate a measurement. Use the READ? command to
query the DC V measurement value with specified range or the CONF? command to query the DC V function configu-

ration.

Parameter:

<Range> 400mV, 4V, 40V, 400V, 1000V
AUTO: Auto range
MIN: 400mV
MAX: 1000V

DEFault: 400mV

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO

[SENSe:1VOLTage[:DCI:NULL[:STATe] {ONIOFF}
Turns the null function for DC V measurement function on or off.

Parameters:
<State> ON | OFF
ON: Null function of DC V measurement function is activated
OFF: Null function of DC V measurement function is disabled
*RST: OFF
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[SENSe:1VOLTage[:DCI:NULL[:STATe]?
Returns the null function state of the DC V measurement function.

Return values:

<State> 110
1 ON - Null function of the DC V measurement function is activated
0 OFF - Null function of the DC V measurement function is disabled

[SENSe:1VOLTage[:DCI:NULL:VALue {<Value>|MIN|MAX}
Sets the null value of the DC V measurement function.

Parameters:

<Value> -1000V to 1000V (adjustable in 1nV steps)
MIN: -1000V
MAX: 1000V
*RST: oV

[SENSe:1VOLTage[:DCI:NULL:VALue? [{MINIMAX}]
Returns the null value of the DC V measurement function.

Return values:
<Value> -1000V to 1000V

MIN: ~ -1.000000E+03
MAX:  1.000000E+03

[SENSe:]1VOLTage[:DC]:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the DC V measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the DC V measurement function
OFF: Disables the auto range mode of the DC V measurement function
1 Activates the auto range mode of the DC V measurement function
0: Disables the auto range mode of the DC V measurement function

[SENSe:1VOLTage[:DCI:RANGe:AUTO?
Returns the auto mode state of the DC V measurement function.

Return values:

<State> 110
1: Auto range of the DC V measurement function is activated
0: Auto range of the DC V measurement function is disabled
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[SENSe:]VOLTage[:DC]:RANGe[:UPPer] {<Range>|MINIMAX|DEF}
Sets the DC V measurement function range.

Parameters:

<Range> 400mV, 4V, 40V, 400V, 1000V
MIN: 400mV
MAX: 1000V

DEFault: 1000V

*RST: AUTO

[SENSe:1VOLTage[:DC]:RANGe[:UPPer]? [{MINIMAX}]
Returns the state of the DC V measurement function range.

Return values:
<Range> 400mV, 4V, 40V, 400V, 1000V

MIN:  4.00000000E-01
MAX:  1.00000000E+03

[SENSe:1VOLTagel[:DC]:ZERO:AUTO <Mode>
Activates or disables the auto zero mode of the DC V measurement function.

Parameters:

<Mode> ONIOFFIT110
ON: Activates the auto zero mode of the DC V measurement function
OFF: Disables the auto zero mode of the DC V measurement function
1: Activates the auto zero mode of the DC V measurement function
0: Disables the auto zero mode of the DC V measurement function

[SENSe:1VOLTagel[:DC]:ZERO:AUTO?
Returns the auto mode state of the DC V measurement function.

Return values:

<State> 110
1: Auto zero mode of the DC V measurement function is activated
0: Auto zero mode of the DC V measurement function is disabled
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Diode configuration commands

CONFIGUIEIDIODE ..., 47
[SENSe:]DIODe:THReshold {<Threshold>IMINIMAXIDEF}.........ccooooiiiiiiiiiiiiee 47
[SENSe:IDIODe:THReshold? [{MINIMAXIDEF} ... 47
[SENSe:IDIODe:BEEPer[:STATe]l {ONIOFF} ... ..o 47
[SENSe:IDIODE:BEEPEI:STATEI? ..o 48
CONFigure:DIODe

Configures the instrument for diode measurements, but does not initiate a measurement. Use the READ? command
to query the diode measurement value or the CONF? command to query the general function configuration.

[SENSe:1DIODe:THReshold {<Threshold>IMIN|IMAXIDEF}
Sets the threshold of the diode measurement function. In this case, the instrument does not switch into continuity
mode. For activating the continuity measurement function use the FUNC command.

Parameters:

<Threshold> 0V to 5V (adjustable in 1uV steps)
MIN: ov
MAX: 5V

DEFault: 700mV

*RST:  700mV

[SENSe:1DIODe:THReshold? [{MINIMAXIDEF}]
Returns the threshold of the diode measurement function.

Return values:
<Threshold> 0V to 5V

MIN:  0.00000000E+00
MAX:  4.94999981E+00
DEFault: 6.99999988E-01

[SENSe:1DIODe:BEEPer[:STATe] {ON|OFF}
Turns the beeper function for diode measurements on or off.

Parameters:
<State> ON | OFF
ON: Beeper of the diode measurement function is activated
OFF: Beeper of the diode measurement function is disabled
*RST. OFF
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[SENSe:1DIODe:BEEPer[:STATe]?
Returns the beeper function state of the diode measurement function.

Return values:

<State> 110
1 ON - beeper of the diode measurement function is activated
0 OFF - beeper of the diode measurement function is disabled

Frequency configuration commands

CONFigure:FREQUENCY[:VOLTAGE] .. ..oiiiiiio e 48
CONFigure:FREQUEeNCY:CURRENT .....c..vviiiicc e, 48
[SENSe:]JFREQuency:APERture {<Seconds>IMINIMAXIDEF} ........c..c.ccciviiiin, 48
[SENSe:]JFREQuency:APERture? [{MINIMAXH . .....oooiiiiiiii e 49
[SENSe:]JFREQuency:CURRent:RANGe:AUTO <Mode>.........ccoooeieiiiiiiii 49
[SENSe:]IFREQuency:CURRent:RANGE: AUTO? ..o 49
[SENSe:]JFREQuency:CURRent:RANGe[:UPPer] {<Current_Range>IMINIMAXIDEF} 49
[SENSe:]JFREQuency:CURRent:RANGe[:UPPer]? [{(MINIMAXH .......ccccooviiiiiiiiiinn 49
[SENSe:]JFREQuency:VOLTage:RANGe:AUTO <Mode>.........ooooiiiiiiiiiiiiiiice 50
[SENSe:IFREQuency:VOLTage:RANGE:AUTO? ...ooviiiiiieeeeeeee e 50
[SENSe:]JFREQuency:VOLTage:RANGe[:UPPer] {<Voltlage_Range>IMINIMAXIDEF} 50
[SENSe:]JFREQuency:VOLTage:RANGe[:UPPer]? [MINIMAX} .....oooiiiiiiiiiiiei 50

CONFigure:FREQuency[:VOLTAGE]

Configures the instrument for frequency measurements, but does not initiate a measurement. Use the READ? com-
mand to query the frequency measurement value or the CONF? command to query the frequency function configurati-
on in AC V mode.

CONFigure:FREQuency:CURRent

Configures the instrument for frequency measurements, but does not initiate a measurement. Use the READ? com-
mand to query the frequency measurement value or the CONF? command to query the frequency function configurati-
onin AC | mode.

[SENSe:1FREQuency:APERture {<Seconds>|MIN|MAXIDEF}
Sets the gate time of the frequency measurement function in AC V / AC | mode.

Parameters:
<Seconds> 10ms, 100ms, 1s
MIN: 10ms
MAX: 1s
DEFault: 1s
*RST.  1s
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[SENSe:IFREQuency:APERture? [{MIN|MAX}]
Returns the gate time of the frequency measurement function in AC V / AC | mode.

Return values:
<GateTime> 1.00000000E-02, 1.00000000E-01, 1.00000000E+00

MIN: 1.00000000E-02
MAX:  1.00000000E+00

[SENSe:1IFREQuency:CURRent:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the AC | measurement function for frequency measurements.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the AC | measurement function
OFF: Disables the auto range mode of the AC | measurement function
1 Activates the auto range mode of the AC | measurement function
0: Disables the auto range mode of the AC | measurement function
*RST:  ON

[SENSe:1IFREQuency:CURRent:RANGe:AUTO?
Returns the auto range state of the AC | measurement function for frequency measurements.

Parameters:

<Mode> 110
1 Auto range mode of the AC | measurement function is activated
0: Auto range mode of the AC | measurement function is disabled

[SENSe:1IFREQuency:CURRent:RANGe[:UPPer] {<Current_Range>|MIN|MAXIDEF}
Sets the current range of the AC | measurement function for frequency measurements.

Parameters:

<Current_Range> 20mA, 200mA, 2A, 10A
MIN: 20mA
MAX: 10A

DEFault: 20mA

*RST: AUTO

[SENSe:IFREQuency:CURRent:RANGe[:UPPer]? [{MINIMAX}]
Returns the current range of the AC | measurement function for frequency measurements.

Return values:

<Current_Range> 20mA, 200mA, 2A, 10A
MIN: 2.00000000E-02
MAX: 1.00000000E+01

DEFault: 2.00000000E-02
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[SENSe:IFREQuency:VOLTage:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the AC V measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the AC V measurement function
OFF: Disables the auto range mode of the AC V measurement function
1: Activates the auto range mode of the AC V measurement function
0: Disables the auto range mode of the AC V measurement function
*RST:  ON

[SENSe:1IFREQuency:VOLTage:RANGe:AUTO?
Returns the auto range state of the AC V measurement function for frequency measurements.

Parameters:

<Mode> 110
1: Auto range mode of the AC V measurement function is activated
0: Auto range mode of the AC V measurement function is disabled

[SENSe:1IFREQuency:VOLTage:RANGe[:UPPer] {<Voltlage_Range>|MINIMAXIDEF}
Sets the voltage range of the AC V measurement function for frequency measurements.

Parameters:

<Voltlage_Range> 400mV, 4V, 40V, 400V, 750V
MIN: 400mV
MAX: 750V

DEFault: 400mV

*RST: AUTO

[SENSe:IFREQuency:VOLTage:RANGe[:UPPer]? [{MINIMAX}]
Returns the voltage range of the AC V measurement function for frequency measurements.

Return values:

<Voltlage_Range> 400mV, 4V, 40V, 400V, 750V
MIN: 4.00000000E-01
MAX: 7.50000000E+02

DEFault: 4.00000000E-01
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4-wire resistance configuration commands

CONFigure:FRESistance [{<Range>IAUTOIMINIMAXIDEF}H ........ooovviiiiiiiiic, 51
[SENSe:]FRESistance:NULL[:STATE] {ONIOFF} ... 51
[SENSe:]FRESistance:NULLESTATEI? ... 51
[SENSe:]FRESistance:NULL:VALue {<Value>IMINIMAX} ........cccooiiiiiiiii 52
[SENSe:]FRESistance:NULL:VALue? {MINIMAX} ... 52
[SENSe:]FRESistance:RANGE:AUTO <MOAE> ......ovvviiiiiiiiiiiieeeee e 52
[SENSe:]FRESistance:RANGE:AUTO? ... 52
[SENSe:]FRESistance:RANGe[:UPPer] {<Range>IMINIMAXIDEF} ...........ccccccoen. 52
[SENSe:]FRESistance:RANGe[:UPPer]? {IMINIMAXH ... 53

CONFigure:FRESistance [{<Range->|AUTOIMIN|MAXIDEF}]

Configures the instrument for 4-wire resistance measurements, but does not initiate a measurement. Use the READ?
command to query the 4-wire resistance measurement value with specified range or the CONF? command to query
the 4-wire resistance function configuration.

Parameter:

<Range> 400Q, 4kQ, 40kQ, 400kQ, 4MQ
AUTO: Auto range
MIN: 400Q
MAX: AMQ

DEFault: 400Q

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO

[SENSe:IFRESistance:NULL[:STATe] {ON|OFF}
Turns the null function for 4-wire (4w) resistance measurement function on or off. In this case, the instrument does not
switch into resistance mode. For activating the Q measurement function use the FUNC command.

Parameters:

<State> ON | OFF
ON: Null function of 4w resistance measurement function is activated
OFF: Null function of 4w resistance measurement function is disabled
*RST:  OFF

[SENSe:IFRESistance:NULL[:STATe]?
Returns the null function state of the 4-wire (4w) resistance measurement function.

Return values:

<State> 110
1 ON - Null function of the 4w resistance measurement function is activated
0 OFF - Null function of the 4w resistance measurement function is disabled
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[SENSe:]IFRESistance:NULL:VALue {<Value>|MIN|MAX}
Sets the null value of the 4-wire (4w) resistance measurement function.

Parameters:

<Value> 0Q to 4MQ (adjustable in 1Q steps)
MIN: 0Q
MAX: 4MQ
*RST: 0Q

[SENSe:IFRESistance:NULL:VALue? [{MINIMAX}]
Returns the null value of the 4-wire (4w) resistance measurement function.

Return values:
<Value> 0Q to 4MQ

MIN: 0.0E+00
MAX:  4.000000E+06

[SENSe:1FRESistance:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the 4-wire (4w) resistance measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the 4w resistance measurement function
OFF: Disables the auto range mode of the 4w resistance measurement function
1: Activates the auto range mode of the 4w resistance measurement function
0: Disables the auto range mode of the 4w resistance measurement function
*RST:  ON

[SENSe:IFRESistance:RANGe:AUTO?
Returns the auto mode state of the 4-wire (4w) resistance measurement function.

Return values:

<State> 110
1 Auto range of the 4w resistance measurement function is activated
0: Auto range of the 4w resistance measurement function is disabled

[SENSe:]FRESistance:RANGe[:UPPer] {<Range>IMINIMAXI|DEF}
Sets the 4-wire (4w) resistance measurement function range.

Parameters:
<Range> 400Q), 4kQ, 40kQ, 400kQ, 4MQ
MIN: 400Q
MAX: 4MQ
DEFault: 400Q
*RST: AUTO
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[SENSe:1IFRESistance:RANGe[:UPPer]? [{MINIMAX}]
Returns the state of the 4-wire (4w) resistance measurement function range.

Return values:
<Range> 400Q), 4kQ, 40kQ, 400kQ, 4MQ

MIN:  4.00000000E+02
MAX:  4.00000000E+06

2-wire resistance configuration commands

CONFigure:RESistance [{<Range>IAUTOIMINIMAXIDEF} ........ccccooiiiiiiiiiic 53
[SENSe:]RESistance:NULLE:STATe] {ONIOFF} . ...ooiiiieeee e, 53
[SENSe:]RESistance:NULLLESTATEI? ... 54
[SENSe:]RESistance:NULL:VALue {<Value>IMINIMAX} ... 54
[SENSe:]RESistance:NULL:VALue? {MINIMAXY ... 54
[SENSe:]RESistance:RANGe:AUTO <MOde>......oooviiiiiiiiii e 54
[SENSe:]RESistance:RANGEAUTO? ..o, 54
[SENSe:]RESistance:RANGe[:UPPer] {<Range>IMINIMAXIDEF} ............ccocoeiiiin. b5
[SENSe:]RESistance:RANGe[:UPPer]? [IMINIMAXH ... 55

CONFigure:RESistance [{<Range>|AUTOIMINIMAXIDEF}]

Configures the instrument for 2-wire resistance measurements, but does not initiate a measurement. Use the READ?
command to query the 2-wire resistance measurement value with specified range or the CONF? command to query
the 2-wire resistance function configuration.

Parameter:

<Range> 400Q, 4kQ, 40kQ, 400kQ, 4MQ, 40MQ, 250MQ
AUTO: Auto range
MIN: 400Q
MAX: 250MQ

DEFault: 400Q

If the input signal is greater than can be measured on the selected range (manual ranging),
the instrument returns 9.90000000E+37.

*RST: AUTO

[SENSe:1RESistance:NULL[:STATe] {ONIOFF}
Turns the null function for 2-wire (2w) resistance measurement function on or off. In this case, the instrument does not
switch into resistance mode. For activating the Q measurement function use the FUNC command.

Parameters:
<State> ON I OFF
ON: Null function of 2w resistance measurement function is activated
OFF: Null function of 2w resistance measurement function is disabled
*RST: OFF
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[SENSe:1RESistance:NULL[:STATel?
Returns the null function state of the 2-wire (2w) resistance measurement function.

Return values:

<State> 110
1 ON - Null function of the 2w resistance measurement function is activated
0 OFF - Null function of the 2w resistance measurement function is disabled

[SENSe:1RESistance:NULL:VALue {<Value>|MIN|MAX}
Sets the null value of the 2-wire (2w) resistance measurement function.

Parameters:

<Value> 0Q to 250MQ (adjustable in 1Q steps)
MIN: 0Q
MAX: 250MQ
*RST:  0Q

[SENSe:1RESistance:NULL:VALue? [{MINIMAX}]
Returns the null value of the 2-wire (2w) resistance measurement function.

Return values:
<Value> 0Q to 250MQ

MIN: 0.0E+00
MAX:  2.500000E+08

[SENSe:1RESistance:RANGe:AUTO <Mode>
Activates or disables the auto range mode of the 2-wire (2w) resistance measurement function.

Parameters:

<Mode> ONIOFFI110
ON: Activates the auto range mode of the 2w resistance measurement function
OFF: Disables the auto range mode of the 2w resistance measurement function
1: Activates the auto range mode of the 2w resistance measurement function
0: Disables the auto range mode of the 2w resistance measurement function
*RST:  ON

[SENSe:IRESistance:RANGe:AUTO0?
Returns the auto mode state of the 2-wire (2w) resistance measurement function.

Return values:

<State> 110
1 Auto range of the 2w resistance measurement function is activated
0: Auto range of the 2w resistance measurement function is disabled
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[SENSe:1RESistance:RANGe[:UPPer] {<Range>|MIN|MAXIDEF}
Sets the 2-wire (2w) resistance measurement function range.

Parameters:

<Range> 400Q), 4kQ, 40kQ, 400kQ, 4MQ, 40MQ, 250MQ
MIN: 400Q
MAX: 250MQ

DEFault: 400Q

*RST: AUTO

[SENSe:IRESistance:RANGe[:UPPer]? [{MIN|MAX}]
Returns the state of the 2-wire (2w) resistance measurement function range.

Return values:

<Range> 400Q, 4kQ, 40kQ, 400kQ, 4MQ, 40MQ, 250MQ

MIN:  4.00000000E+02
MAX:  2.50000000E+08

Temperature configuration commands

CONFigure:TEMPerature [{<Probe_Type>IDEF} {<Type>IDEF}, 1] ........ccccooovirrnnn. 55
[SENSe:ITEMPerature:NULL[:STATe] {ONIOFF} ... 56
[SENSe: I TEMPerature:NULLLESTATE? ..o 56
[SENSe:]ITEMPerature:NULL:VALue {<Value>IMINIMAX} ...........cooiiiiiiiiii 56
[SENSe:]ITEMPerature:NULL:VALue? {MINIMAX} ....ooooii e 56
[SENSe:ITEMPerature:TRANsducer:RTD:TYPE <Type>......ccccccoooiiiiiiiiiiiiiiiecece 56
[SENSe:ITEMPerature:TRANsducer:RTD:TYPE? ... 57
[SENSe:[TEMPerature:TRANsducer:TYPE <Probe_Type> .........c.coooiiiiiiiiii, 57
[SENSe:ITEMPerature: TRANSAUCENTYPE? .oovviiiiieeee e 57
UNIT-TEMPerature {C 1 K Tl e 57
UNIT-TEMPEIATUIE? ..o 57

CONFigure:TEMPerature [{<Probe_Type>IDEF}[,{<Type>IDEF}[,1]

HAMEL=

Instruments
A Rohde & Schwarz Company

Configures the instrument for 2-wire / 4-wire temperature measurements, but does not initiate a measurement. Use
the READ? command to query the 2-wire / 4-wire temperature measurement value with specified range or the CONF?

command to query the 2-wire resistance function configuration.

Parameter:
<Probe_Type> FRTD | RTD

FRTD: 4-wire temperature value (4W)
RTD: 2-wire temperature value (2W)
DEF: RTD (2W)

<Type> PT100 | PT500 | PT1000
DEF: PT100
Example: CONF:TEMP FRTD,PT500
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[SENSe:1TEMPerature:NULL[:STATe] {ONIOFF}
Turns the null function for temperature measurement function on or off. In this case, the instrument does not switch
into temperature mode (SENSOR). For activating the SENSOR measurement function use the FUNC command.

Parameters:

<State> ON | OFF
ON: Null function of temperature measurement function is activated
OFF: Null function of temperature measurement function is disabled
*RST: OFF

[SENSe:]TEMPerature:NULL[:STATe]?
Returns the null function state of the temperature measurement function.

Return values:

<State> 110
1 ON - Null function of the temperature measurement function is activated
0 OFF - Null function of the temperature measurement function is disabled

[SENSe:]TEMPerature:NULL:VALue {<Value>|MINIMAX}
Sets the null value of the temperature measurement function.

Parameters:

<Value> -273,1°C t0 999,9°C (adjustable in 1u°C steps)
MIN:  -273,1°C
MAX:  999,9°C
*RST: 0°C

[SENSe:ITEMPerature:NULL:VALue? [{MINIMAX}]
Returns the null value of the temperature measurement function.

Return values:
<Value> -273,1°C t0 999,9°C

MIN:  -2.731000E+02
MAX:  9.999000E+02

[SENSe:1TEMPerature:TRANsducer:RTD:TYPE <Type>
Sets the RTD type (PT type) of the temperature measurement function.

Parameters:
<Type> PT100 | PT500 | PT1000
*RST:  PT100
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[SENSe:ITEMPerature:TRANsducer:RTD:TYPE?
Returns the RTD type (PT type) of the temperature measurement function.

Return values:
<Type> PT100 | PT500 | PT1000

[SENSe:ITEMPerature:TRANsducer:TYPE <Probe_Type>
Sets the probe type of the temperature measurement function.

Parameters:
<Probe_Type> FRTD | RTD

FRTD: 4-wire temperature probe type (4W)
RTD: 2-wire temperature probe type (2W)

*RST:  RTD

[SENSe:ITEMPerature:TRANsducer:TYPE?
Returns the probe type of the temperature measurement function.

Return values:
<Probe_Type> FRTD | RTD

FRTD: 4-wire temperature probe type (4W)
RTD: 2-wire temperature probe type (2W)

UNIT:TEMPerature {C | K | F}
Selects the unit of the temperature measurement function.

Parameters:

<Unit> C: °C
K: Kelvins
F: °F

UNIT:TEMPerature?
Selects the unit of the temperature measurement function.

Return values:

<Unit> C: °C is activated
K: Kelvins is activated
F: °F is activated
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ADC rate configuration commands

[SENSe:]JADCRate {SLOW | MEDium | FAST} ............
[SENSE:JADCRAtE? ..o

[SENSe:]ADCRate {SLOW | MEDium | FAST}

A Rohde & Schwarz Company

................................................ 58

Selects the ADC rate for the activated measurement function. The reading rate per second of the ADC rate function is

depending on the activated measurement function.

Parameters:

<Function> SLOW | MEDium | FAST
*RST:  SLOW

[SENSe:]ADCRate?

Returns the ADC rate for the activated measurement function.

Return values:

<Function> SLOW | MED | FAST

Miscellaneous

CONFIQUIE? ..o
[SENSe:]JFUNCtion[:ON] <Function> .................oo....
[SENSe:IFUNCHONEONI? oo

CONFigure?
Returns the actual instrument configuration.

Example: TEMP, PT100, RTD

Usage: Query only

[SENSe:1FUNCtion[:ON] <Function>
Selects the measurement function.

Parameters:
<Function> VOLTagel:DC]
VOLTage:AC
CURRent[:DC]
CURRent:AC
RESistance
FRESistance
FREQuency[:VOLTagel
FREQuency:CURRent
CONTinuity

DIODe

SENSor

*RST:

Example: FUNC VOLT:AC

................................................ 58
................................................ 58
................................................ 59

DC V measurement function

AC V measurement function

DC | measurement function

AC | measurement function

2-wire resistance measurement function

4-wire resistance measurement function
Frequency measurement function in AC V mode
Frequency measurement function in AC | mode
Continuity measurement function

Diode measurement function

Sensor measurement function

VOLTI:DC]
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[SENSe:1FUNCtion[:0ON]?
Returns the selected measurement function.

Return values:

<Function> VOLT DC V measurement function
VOLT:AC AC V measurement function
CURR DC | measurement function
CURR:AC AC | measurement function
RES 2-wire resistance measurement function
FRES 4-wire resistance measurement function
FREQ Frequency measurement function in AC V mode
FREQ:CURR Frequency measurement function in AC | mode
CONT Continuity measurement function
DIOD Diode measurement function
SENS Sensor measurement function
Example: FREQ:CURR

2.5 Mathematic Functions

CALCulate:FUNCtion {NULL | DB | DBM | AVERage | LIMit | POWer}....................... 59
CALCUIAtE FUN C I ON 2 e 60
CALCUlatel:STATE] {OFF I ON Y e 60
CALCUIAtELSTATEI? oo 60
CALCUIAtEIPOWET? .o 60
CALCulate:LIMit:LOWer {<Value> | MINimum | MAXimum}...........ooooooiiiii 61
CALCulate:LIMit:LOWer? {MINimum | MAXIMUMY ..o 61
CALCulate:LIMit:UPPer {<Value> | MINimum | MAXIimumM} .......cccoooeiiiiiii 61
CALCulate:LIMit:UPPer? {MINimum | MAXIMUM} ... 61
CALCulate:DB:REFerence {<Value> | MINimum | MAXimumM}.........ccoooeeeiiiiiiinnnn 61
CALCulate:DB:REFerence? {MINimum | MAXIMUM} ... 61
CALCulate:DBM:REFerence {<Value> | MINimum | MAXimum}..........ccooooovvivnnnnnen. 61
CALCulate:DBM:REFerence? {MINimum | MAXIMUMY} ... 62
CALCulate:NULL:OFFSet {<Value> | MINimum | MAXimumM} .......ccccoooeeeiiiiiii. 62
CALCulate:NULL:OFFSet? {IMINimum | MAXIMUM} ... 62
CALCulate:AVERAGEIAVERAGE? ....cooiiiiiieieee e, 62
CALCulate:AVERAGEICLEAr ... 62
CALCulate:AVERAGEICOUNL? ..o 62
CALCulate:AVERAGE:MAXIMUM? ..o 62
CALCulate:AVERaGE:MINIMUM? ..o 63
CALCulate:AVERAGEIPTPEAK? ......coiiiiiiiiiiecc e, 63
CALCulate:AVERage:SDEVIAtioN? .. ....vvviiiiiiii e, 63

CALCulate:FUNCtion {NULL | DB | DBM | AVERage | LIMit | POWer}
Sets the calculation function, but does not activate the function. Use the CALC ON command to activate the
calculation function.

Parameters:

<Function> NULL: Null function
DB: dB function
DBM: dBm function
AVERage:  Statistic measurements
LIMit: Limit lines

POWer: Power display

The following table shows the possible math/measurement function combinations.
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Measurement . .
function Mathematic functions
Stats ..

DCV ® ® ) ® ® ¢
(only with 2nd function DC 1)

ACV ® ® ) ® ® =

DCI ® ® ) ® ) ¢
(only with 2nd function DC 1)

ACI ® ® ) ® ) =

Q0 ® ® ) = = =

CAP ® ® ) = = =

SENSOR ® = ) ) = =

S D I D I -

Tab. 2.1: Measurement functions with possible math options

CALCulate:FUNCtion?
Returns the calculation function.

Return values:

<Function> NULL: Null function
DB: dB function (available in DCVACV, DC I, AC I)
DBM: dBm function (available in DCV ACV, DC I, AC )
AVER: Statistic measurements
LIM: Limit lines
POW: DC power value (available in DC V/DC | or DC I/DC V mode)

CALCulate[:STATe] {OFF | ON}
Turns with the CALC FUNC command selected calculation function on or off.

Parameters:

<State> ON: The selected calculation function is activated.
OFF: The selected calculation function is disabled.

CALCulate[:STATel?

Returns the state of the CALC FUNC command selected calculation function.

Return values:

<State> 110
1 ON - Calculation function is activated.
0 OFF - Calculation function is disabled.
CALCulate:POWer?
Returns the DC power value. To activate the power display function use the CALC:FUNC POW resp. the CALC ON
command.

Return values:

<Value> If the HMC8012 is not configured in DCI/DCV or DCV/DCI mode ,-1" will be returned.
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CALCulate:LIMit:LOWer {<Value> | MINimum | MAXimum}
Sets the low limit value of the limit line function. The possible maximum and minimum low limit value is depending on
the activated measurement function. To activate the limit lines use the CALC:FUNC LIM resp. the CALC ON command

Parameters:
<Value> Depending on the activated measurement function

CALCulate:LIMit:LOWer? {MINimum | MAXimum}
Retuns the low limit value of the limit line function.

Return values:
<State> e.g. -7.500E+02

CALCulate:LIMit:UPPer {<Value> | MINimum | MAXimum}

Sets the high limit value of the limit line function. The possible maximum and minimum high limit value is depending
on the activated measurement function. To activate the limit lines use the CALC:FUNC LIM resp. the CALC ON com-
mand

Parameters:
<Value> Depending on the activated measurement function

CALCulate:LIMit:UPPer? {MINimum | MAXimum}
Retuns the high limit value of the limit line function.

Return values:
<Value> e.g. -7.500E+02

CALCulate:DB:REFerence {<Value> | MINimum | MAXimum}
Stores a relative value which is used for the dB function. The possible dB reference value is depending on the activa-
ted measurement function. To activate the dB function use the CALC:FUNC DB resp. the CALC ON command

Parameters:
<Value> Depending on the activated measurement function

CALCulate:DB:REFerence? {MINimum | MAXimum}
Retuns the dB reference value.

Return values:
<Value> e.g. 1.0E-06

CALCulate:DBM:REFerence {<Value> | MINimum | MAXimum}
Sets the user defined dBm reference resistance value. To activate the dBm function use the CALC:FUNC DBM resp.
the CALC ON command.

Parameters:
<Value> 1Q to 65,5kQ (adjustable in 1Q steps)
MIN: 1Q
MAX:  65,5kQ
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CALCulate:DBM:REFerence? {MINimum | MAXimum}
Returns the user defined dBm reference resistance value.

Return values:
<Value> e.g. 6.000E+02

CALCulate:NULL:OFFSet {<Value> | MINimum | MAXimum}
Sets the maximum null value depending on the activated measurement function.

Parameters:
<Value> Depending on the activated measurement function

CALCulate:NULL:OFFSet? {MINimum | MAXimum}
Returns the maximum null value depending on the activated measurement function.

Return values:
<Value> e.g. 1.00E+01

CALCulate:AVERage:AVERage?
Returns the mean value of the statistic function depending on the activated measurement function. To activate the
statistic function use the CALC:FUNC AVER resp. the CALC ON command.

Return values:
<Value> e.g. 1.82852E-07

Usage: Query only

CALCulate:AVERage:CLEar
Resets all statistic function values .

Usage: Setting only

CALCulate:AVERage:COUNt?
Returns the number of statistic measurement counts. You can read the statistical values at any time.

Return values:
<Value> e.g. 1.000E+02 (Count = 100)

Usage: Query only

CALCulate:AVERage:MAXimum?
Returns the maximum value (Max) of the statistic function depending on the activated measurement function. To acti-
vate the statistic function use the CALC:FUNC AVER resp. the CALC ON command.

Return values:

<Value> e.g. 1.55606E-07

Usage: Query only
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CALCulate:AVERage:MINimum?
Returns the minimum value (Min) of the statistic function depending on the activated measurement function. To acti-
vate the statistic function use the CALC:FUNC AVER resp. the CALC ON command.

Return values:
<Value> e.g. 2.24768E-07

Usage: Query only

CALCulate:AVERage:PTPeak?
Returns the peak to peak value (Pk to Pk) of the statistic function depending on the activated measurement function.
To activate the statistic function use the CALC:FUNC AVER resp. the CALC ON command.

Return values:
<Value> e.g. 6.91621E-08

Usage: Query only

CALCulate:AVERage:SDEViation?
Returns the standard deviation value (StdDev) of the statistic function depending on the activated measurement func-
tion. To activate the statistic function use the CALC:FUNC AVER resp. the CALC ON command.

Return values:
<Value> e.g. 1.50020E-08

Usage: Query only

2.6 Data and File Management

DATA:LOGL:STATEI{O I T TOFF TON} e 64
D AT A L O G ST AT 2 e 64
DATA:LOG:FNAMe {<"File_Name">}[{INT  EXT I DEF}] ...ooooiiiiiiii, 64
DATAILOGIENAME? ..o 64
DATA:LOG:FORMat {CSV I TXT} oo 64
DATALOG:FORMAL? ..o, 64
DATA:LOG:MODE {UNLimited  COUNt I TIME}........oooiiiiiiiiiiiieceeeee 65
DATAILOGIMODE? ... 65
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DATA:LOG[:STATe]l {0 1| OFF | ON}
Turns the data logging function on or off.

Parameters:

<State> ON/1: Data logging function is activated.
OFF / 0: Data logging function is disabled.

DATA:LOG[:STATe]?

Returns the state of the data logging function.

Return values:

<State> 110
1 ON - Data logging function is activated.
0 OFF - Data logging function is disabled.

DATA:LOG:FNAMe {<“File_Name“>},[{INT | EXT | DEF}]
Defines the file name and storage location for the logging function.

Parameters:
<File_Name> e.g. "Test01.CSV",INT
INT: Internal memory
EXT: USB stick
DEF: Internal memory
DATA:LOG:FNAMe?

Returns the file name and storage location for the logging function.

Return values:

<File_Name> e.g. "/INT/DATA/Test01.CSV"
INT: Internal memory
EXT: USB stick
DEF: Internal memory

DATA:LOG:FORMat {CSV | TXT}
Defines the data logging file format.

Parameters:
<Format> CSv Comma separated values
TXT Text file
*RST: CSV
DATA:LOG:FORMat?

Returns the data logging file format.

Return values:

<Format> CSV I TXT
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DATA:LOG:MODE {UNLimited | COUNt | TIME}
Selects the data logging mode.

Parameters:

<Mode> UNLimited Infinite data capture
COUNt Number of measurement values to be captured
TIME Duration of the measurement values capture
*RST: UNL

DATA:LOG:MODE?

Returns the data logging mode.

Return values:

<Mode> UNL Infinite data capture
COUN Number of measurement values to be captured
TIME Duration of the measurement values capture

DATA:LOG:TIME <time in seconds>
Sets the data logging time.

Parameters:
<Time> Internal: 50000h max.
External: Defined by USB stick capacity

DATA:LOG:TIME?
Returns the duration of the measurement values capture.

Return values:
<Time> e.g. 5.00000E+04

DATA:LOG:COUNt <no of samples>
Sets the number of measurement values to be captured.

Parameters:
<Samples> Internal: 50000 max.

External: Defined by USB stick capacity
DATA:LOG:COUNt?

Returns the number of measurement values to be captured.

Return values:
<Time> e.g. 1.00E+01

DATA:LOG:INTerval <interval in seconds>
Selects a logging measurement interval. The measurement interval describes the time between the recorded

measurements.
Parameters:
<Interval> 3600s max.
*RST: Os
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DATA:LOG:INTerval?
Returns the selected logging measurement time.

Return values:
<Time> e.g. 1.0E+00

DATA:DATA? {<“File_Name“>},[{INT| EXT | DEF}]

Returns the logging file data values of the selected storage location and file name. If no logging file is found, the
message ,, No Logging Files found” is displayed. If no storage location is selected, the instrument queries the internal
memory. Please notice that the logging function has to be activated, if you want to use the manual or single trigger
mode (trigger via TRIG button). Without activating the logging function in single or manual trigger mode, the instrument
is not able to save a logging file internally or on the USB stick.

Return values:

<File_Name> e.g. "LOG0029.CSV”
INT: Internal memory
EXT: USB stick
DEF: Internal memory
Example: External logging file (USB stick) of single trigger, count =5

DATA:DATA? ,LOG0029.CSV” ,EXT

# HAMEG -Log-File ;

# Date: 2013-05-23 ;

# Start Time:, 15:09:32;
# Stop Time:, 15:10:03 ;
# Settings: ;

#9> ADC Rate : Fast;
#9 AC Filter : ——- ;
#D Input Imp. : 10M;
DCV[V],DCI[A],Flag;
12.891854, 0.982340 ;
12.889381, 0.982539 ;
12.909376, 0.982238 ;
12.875769, 0.982418 ;
12.844559, 0.982506 ;
12.863085, 0.982463 ;

Usage: Query only

DATA:DELete {<“File_Name“>},[{INT | EXT | DEF}]

Deletes the logging file data values of the selected storage location and file name. If no storage location is selected,
the instrument uses the internal memory. Please notice that the logging function has to be activated, if you want to
use the manual or single trigger mode (trigger via TRIG button). Without activating the logging function in single or
manual trigger mode, the instrument is not able to save a logging file internally or on the USB stick.

Parameters:
<File_Name> e.g. "LOG0029.CSV”
INT: Internal memory
EXT: USB stick
DEF: Internal memory
Example: DATA:DEL ,LOG0029.CSV" EXT
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DATA:POINts? {<“File_Name“>},[{INT | EXT | DEF}]

Returns the number of log file values of the selected storage location and file name. If no storage location is selected,
the instrument queries the internal memory. Please notice that the logging function has to be activated, if you want
to use the manual or single trigger mode (trigger via TRIG button). Without activating the logging function in single or
manual trigger mode, the instrument is not able to save a logging file internally or on the USB stick.

Return values:

<Value> INT: Max. 50,000 (internal memory)
EXT: Max. memory size of the USB stick
DEF: 50,000 (internal memory)

Example: External logging file (USB stick) of single trigger, count = 5
DATA:POIN? ,,LOG0029.CSV" EXT

Query: 5

DATA:LIST? [{INT | EXT | DEF}]

Returns all saved logging files of the selected storage location. If no storage location is selected, the instrument que-
ries the internal memory. Please notice that the logging function has to be activated, if you want to use the manual or
single trigger mode (trigger via TRIG button). Without activating the logging function in single or manual trigger mode,
the instrument is not able to save a logging file internally or on the USB stick. If you store the logging file on the USB
stick, the query returns all files depending on the storage format (CSV or TXT files).

Return values:

<List> INT: Internal memory
EXT: USB stick
DEF: Internal memory
Example: DATA:LIST? EXT
Query: ,LOGO0001.CSV", "LOG0002.CSV","LOG0003.CSV”
HCOPy:DATA?

Returns the actual display content (screenshot). The DATA? query responses the screenshot data in binary format.

Usage: Query only

HCOPy:FORMat { BMP | PNG }
Selects the data format of the screenshot.

Parameters:

<Format> BMP | PNG
BMP: Windows Bitmap Format
PNG: Portable Network Graphic
*RST: BMP
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HCOPy:FORMat?
Returns the current setting of the screenshot format.

Return values:

<Format> BMP | PNG
BMP: Windows Bitmap Format
PNG: Portable Network Graphic

HCOPy:SIZE:X?
Returns the horizontal expansion of the screenshots.

Usage: Query only

HCOPy:SIZE:Y?
Returns the vertical expansion of the screenshots.

Usage: Query only

*SAV {0111213]4}

A Rohde & Schwarz Company

Stores the current instrument state in the specified storage location. Any state previously stored in the same location

is overwritten (no error is generated).

*RCL {0l112I314}

Recalls the current instrument state of the specified storage location.
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2.7
2.7.1

Status Reporting
STATus:0PERation Register

The commands of the STATus : OPERation subsystem control the status reporting structures of the
STATus:OPERation register:

See also:

— chapter 1.6.1, , Structure of a SCPI Status Register”, on page 14
. STATus:OPERation Register”, on page 17
— Diagram on page 20

The following commands are available:

STATUS:OPERation:CONDITION? ..o 69
STATus:OPERation:ENABIle <Enable_Value> ... 69
STATUS:OPERAtioN: ENABIE? . o 69
STATUS:OPERAtION EV ENT] 2 e 69

STATus:0PERation:CONDition?

Returns the of the CONDition part of the operational status register.

Return values:

<Condition> Condition bits in decimal representation.
Range: 1 1o 65535

Increment: 1

Usage: Query only

STATus:OPERation:ENABle <Enable Value>
Parameters:

<Enable_Value> Range: 1 to 65535
Increment: 1

STATus:0PERation:ENABle?
Enables the bits in the enable register for the Standard Operation Register group.

STATus:0PERation[:EVENt]?

Return values:

<Event> Range: 1 to 65535
Increment: 1

Usage: Query only
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2.7.2 STATus:QUEStionable Registers
The commands of the STATus : QUEStionable subsystem control the status reporting structures of the
STATus:QUEStionable registers:

See also:

— chapter 1.6.1, , Structure of a SCPI Status Register”, on page 14
. STATus:QUEStionable Register”, on page 18

— Diagram on page 20

The following commands are available:

ST ATUS P RE S Ot e 70
STATus:QUEStionable:CONDITION? ..o 70
STATus:QUEStionable:ENABIle <Enable_Value> ...............ccccccciiiiiiiiiiiiiiii 70
STATUS:QUEStIoNable:ENABIE? ... 70
STATUs:QUEStionable[:EVENTI? ..o o, 71
STATus:PRESet

Resets all bits of the STATUS:QUESTIONALBLE and Standard Operation enable register.

Usage: Event

STATus:QUEStionable:CONDition?
Returns the contents of the CONDition part of the status register to check for questionable instrument or measure-
ment states. Reading the CONDition registers does not delete the contents.

Return values:

<Condition> Condition bits in decimal representation
Range: 1 to 65535
Increment: 1

Usage: Query only

STATus:QUEStionable:ENABLle <Enable_Value>

Sets the enable mask that allows true conditions in the EVENTt part to be reported in the summary bit. If a bit in the
enable part is set to 1 and its associated event bit transitions to true, a positive transition occurs in the summary bit
and is reported to the next higher level.

Parameters:

<Enable_Value> Bit mask in decimal representation
Range: 1 to 65535
Increment: 1

STATus:QUEStionable:ENABle?
Reads the enable register and returns a decimal value which corresponds to the binary-weighted sum.
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STATus:QUEStionable[:EVENt]?

Returns the contents of the EVENTt part of the status register to check whether an event has occurred since the last
reading. Reading an EVEN1 register deletes its contents.

Return values:

<Event> Event bits in decimal representation
Range: 1 to 65535
Increment: 1
Usage: Query only
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